
Camtasia Relay®
Administrator Website Help

Version 4.3.0
April 2013

© 2013 TechSmith Corporation



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - ii -

All rights reserved

This manual, as well as the software described in it, is furnished under license andmay be used or copied only
in accordance with the terms of such license. The content of this manual is furnished for informational use
only, is subject to change without notice and should not be construed as a commitment by TechSmith Cor-
poration. TechSmith Corporation assumes no responsibility or liability for any errors or inaccuracies that may
appear in this manual.

Trademarks

All-in-One Capture, Camtasia, Camtasia Relay, Camtasia Studio, Coach's Eye, DubIt, EnSharpen, Enter-
priseWide, Expressshow, Jing, Morae, Rich Recording Technology (RRT), Screencast.com, ScreenChomp,
Show TheWorld, SmartFocus, Snagit, TechSmith, TechSmith Fuse, TSCC and UserVue are either reg-
isteredmarks or marks of TechSmith Corporation in the U.S. and/or other countries. This list is not a com-
prehensive list of all TechSmith Corporationmarks. The absence of a name/mark or logo in this notice does
not constitute a waiver of any intellectual property rights that TechSmith Corporation has established in any of
its product, feature or service names/marks or logos. All other marks are the property of their respective own-
ers.



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - iii -

Table of Contents
Introduction 1

Camtasia Relay Overview 2

Important Camtasia Relay Concepts 3

Profiles 3

Variables 3

Administrators Cannot Record Presentations 4

Camtasia Relay Recorder 4

Configuration of Camtasia Relay 5

1. Define Publish Destinations 5

Publish Account Setup 6

2. Set Up Notifications 7

Notification Setup 7

3. Create Profiles 9

Define Profiles Settings 9

Select Publish Destinations 10

Select Encode Settings 10

Select Publish Accounts 11

Select Notifications 12

Assign Notifications 12

Define Profile Variables 13

Associate Users 14

Review the Profile 14

Test the Profile 15

4. Add Users to Camtasia Relay 16

Add LDAP Users to Camtasia Relay 16

Manually Add Users to Camtasia Relay 18

Set User Account Security Settings 19

Activate / Deactivate Camtasia Relay Server 19

Verify Setup 20

Roll-Out Camtasia Relay 21



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - iv -

What Presenters Need to Know Most 21

Sample Emails Administrators Can Modify and Send to Presenters 22

Deploy Camtasia Relay Recorder 24

Camtasia Relay Administration Reference 25

System Menu 25

System 25

Servers 28

System Options 29

Plug-Ins 32

Activation 34

Client Machines 34

Event Log 35

Download Recorders 35

Presentations Menu 37

Presentations 38

Job Status 38

History 39

Profiles Menu 41

Profiles 41

Publish Destination Setup 55

Publish Account Setup 65

Notification Server Setup 68

Install the Camtasia Relay Plug-In on the Moodle Server 70

Configure the Camtasia Relay Plug-In on the Moodle Server 71

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications 72

Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications 73

Notification Setup 77

Variables 80

Users Menu 84

Users 84

LDAP Import 86

LDAP Configuration 86



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - v -

User Account Security Settings 88

Need More Help 91

Working with Technical Support 92

Step 1: Knowledge Base Search 92

Step 2: Submit a Question 92

Step 3: Call Tech Support 93

How to Export Event Viewer Logs 93



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - 1 -

Introduction
This document introduces you to Camtasia Relay, walks you through configuring the system, and provides
you with administration information to help you to keep Camtasia Relay running smoothly.

Camtasia Relay Administration Help Topics

Camtasia Relay Overview
Important Camtasia Relay Concepts
Configuration of Camtasia Relay
Camtasia Relay Administration Reference
Need More Help
Working with Technical Support
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Camtasia Relay Overview
With Camtasia Relay, you can capture and publish your lecture or presentation anytime, anywhere -- in the
classroom, in the conference room, at your desk, or at home. Camtasia Relay supports a wide variety of video
formats allowing any lecture or presentation to be viewed by your audience onmultiple playback devices
including portable media devices such as the Apple iPod and via iTunes U.

There are two parts to Camtasia Relay—the recorder, which runs on a presenter’s computer, and the server
which processes and publishes all presentations. Watch a short overview video on the TechSmith website.

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
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Important Camtasia Relay Concepts
Before you configure Camtasia Relay, there are several concepts you should be familiar with. Please review
the following topics. You can find additional information in theCamtasia Relay Administration Reference
part of this help.

Profiles
Profiles are the backbone of Camtasia Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profiles are created by the administrator and include settings that define how the presentation is recorded,
processed, and published. Careful consideration of how you want to set up your organization’s profiles helps
simplify maintenance of the profiles over time.

Things to consider:

Youmay want to first create a test profile to make sure that you understand the parts of the profile and
some of the options available to ease day to day maintenance, such as variables.
The profile title is the only thing presenters can see in the recorder. The profile description is only vis-
ible on the website. Consider carefully how you choose profile titles so that they convey their intended
use to presenters.

Good titles:BIO-101, Sales Dept Meetings, Weekly Status Reports, Personal Recordings
Not-so-good titles:MP4Output, John Presenter, 10142

TheUpload and Decide Later Profile sends the recording to the Camtasia Relay server but does not
process the recording in any way. The presentation stays in theNeeds Attention state on the server
until an administrator or the presenter selects a profile to use or deletes the presentation.

For more information, seeProfiles

Variables
Variables can help simplify themanagement of profiles, publish destinations, publish accounts, and noti-
fications. These “placeholders” have a value applied to them at the time a presentation processes.

There are administrator-defined and system-defined variables available:

Administrator-defined variables

Create a variable, use the variable in multiple places, andmanage the value in central location.

For example, you can create a global variable for Semester, add it to a file system publish destination
path and use the publish destination for multiple profiles. When the semester is over, you change the
value once, and the publish destinations paths are automatically adjusted to reflect the change.

System-defined variables

These variables are included in the Camtasia Relay system and change based on the information for
the presentation that is being processed.

For example, you can use the system variable for the presenter’s username in a publish destination file
path such as \\media.company.com\presentations\{s:PresenterUserName}. When the pre-
sentation is published, the presenter’s username is substituted in the file path and places the pre-
sentation in that presenter’s network folder.
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For more information, seeVariables.

Administrators Cannot Record Presentations
Administrators cannot make recordings or log in to the Camtasia Relay recorder.

To record, youmust create a presenter account. The presenter account cannot have the same email address
as the administrator account.

If you are using LDAP, instead of creating a new user in LDAP, create a new user on the Camtasia Relay web-
site. SeeManually Add Users to Camtasia Relay for more information about how to create a new user.

Camtasia Relay Recorder
There are a few ways to access the recorder:

Administrators and presenters can download the Camtasia Relay recorder from the Camtasia Relay
website.
Administrators can also obtain the files at:

{base URL}/Relay/Downloads/WinCamtasiaRelay.exe (Windows)

{base URL}/Relay/Downloads/MacCamtasiaRelay.zip (Mac)

{base URL}/Relay/Downloads/PortableCamtasiaRelay.zip (Portable)

The server URL is hard coded into the recorder. If you havemultiple instances of Cam-
tasia Relay in your organization and are distributing the files to presenters make sure
presenters are installing recorders from the correct server instances.

In a locked-down or controlled environment, the administrator can choose to deploy the Camtasia
Relay recorder forWindow operating systems, instead of having the users download it from the Relay
website.
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Configuration of Camtasia Relay

Before starting configuration, please review Important Camtasia Relay Concepts.

After installation, you need to configure Camtasia Relay beforemaking it available to presenters. Use the fol-
lowing processes to configure your server properly.

1. Define Publish Destinations

2. Set Up Notifications

3. Create Profiles

4. Add Users to Camtasia Relay

Other things to do before you start using Camtasia Relay

Activate / Deactivate Camtasia Relay Server
Roll-Out Camtasia Relay
Deploy Camtasia Relay Recorder

1. Define Publish Destinations
Publish Destinations are the locations that presentations are placed when processing is complete.

Camtasia Relay can publish presentations tomany kinds of media servers. For more information on setting up
a specific type of publish destination, seePublish Destination Setup.

Completed presentations should not be published (hosted) on the Camtasia Relay server.

To Create a Publish Destination

1. Go to Profiles > Publish Destination Setup.
2. Click one of the publish destination types to create a new destination.

If the publish destination you would like to use is not available in the list of publish
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destinations, youmay have to install the appropriate plug-in before you can use it. See
Plug-Ins for more information.

3. Enter all required information. In many cases, you can use variables to help createmulti-purpose pub-
lish destination paths and URLs.

4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

Publish Account Setup
After you create a publish destination, you define the account for Camtasia Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

To Create a Publish Account

1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-
tinations you have set up.

2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
4. If not a default account, select if you want toUse account information from default account. This

allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts

The following informationmight help you inmaking some decisions when creating your publish accounts.

You can let presenters enter their own information.

If you would like to use this option, you do not have to set up a publish account. Instead, you will select
toUse presenter accountwhen configuring a profile.

Each publish destination can have a default account.

This can be helpful in several ways:

You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.
If the default account for a publish destinationmay change from time to time, you can select
Use default accountwhen configuring a profile. You can then change which account is the
default account without having to change anything in the affected profiles. The profiles use the
currently selected default account for a given publish destination.
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You can select different publish accounts for each publish destination/encode setting combination in a
profile.

2. Set Up Notifications
Notifications are the various ways that people are informed when presentations are published. They are sent
per profile and can include information about multiple processed presentations.

To set up notifications, you first configure the notification server and then create custom notifications. If you
want to use the email server you set up during installation, you can skip ahead toNotification Setup.

You can configure three types of notification servers:

BlackBoard:Posts notifications directly to BlackBoard
Email:Sends notifications through the email server.

You can only configure one email server.

Moodle:Posts notifications toMoodle.
For more information on setting up a specific type of notification server, seeNotification Server Setup.

Configure a Notification Server

1. Go toProfiles > Notification Server Setup.
2. Click one of the server types to create a new notification server.

If the notification server type you would like to use is not available in the list of noti-
fication servers, youmay have to install the appropriate plug-in before you can use it.
SeePlug-Ins for more information.

3. Enter all required information.
4. Click Save.
5. The notification server information is saved and you are presented with a link to theNotification Setup

for this server.
6. Click the link to continue withNotification Setup.

Notification Setup
After you configure a notification server, you create notifications to use with that server.
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You can select who receives notification and what kind of information they receive about published pre-
sentations.

For more information on a specific notification type, seeNotification Setup.

Create a Notification

1. On the Notification Setup page (Profiles > Notification Setup), click one of the notification servers.
2. Enter information for the notification. Depending on which server type you select, you will enter dif-

ferent types of information.

You can use variables to allow one notification to be used inmultiple cases. For more information, see
Variables.

3. Select aDetails Template to use.

Click Samples to preview what information each template includes.

This template defines what information to include in the notification. A notification contains information
for each encoding you select to include in this notification in the profile.

ChooseMessage only if you only want to specify amessage and not include additional details.

4. Enter amessage to include in the notification. This can be a personalized greeting, additional pre-
sentation information, or left blank. You can use variables in this field.

5. Click Save.

Things to Consider About Notifications

The following informationmight help you inmaking some decisions when creating notifications.

When you set up a profile, you can choose which encodings you want to include in each notification.

For example, you could create a profile that contains both aWeb video and a CAMREC file. You can
include theWeb video information in a notification that goes straight to viewers and include information
on the CAMREC file in a notification that goes only to the presenter.

You can preview the information included in each of the details templates by clicking the Samples link.
For more information on the details templates, seeDetails Templates.
You can use variables to allow for a single notification to be used for multiple uses.

For example, use the system variable {s:PresenterEmailAddress} in the To field of an email
notification. Any profile that uses that notification always sends an email to the email address of the
presenter associated with the presentation.

If you use variables in themessage of a notification, some variables only receive information from the
last processed encoding in a presentation.

For example, if you use the system variable {s:PublishFilePath} in themessage of a notification
and havemultiple encodings set up in the selected profile, only the file path of last published encoding
is included in themessage.

Camtasia Relay does not send separate notifications for each encoding selected in a profile, but
instead rolls information for each encoding into a single notification.
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For example, if in a profile you select to include three encoding types in a notification, the recipient
receives one notification including information about all three encodings rather than three separate noti-
fications.

3. Create Profiles
After you have defined the publish destination and set up notifications, you are ready to create profiles.

To start creating a new profile:

1. Go toProfiles.
2. Click theNew Profile button.

The Profile Setup page opens.

3. Work through, from top to bottom, the tabs at the left side of the page.

These tabs are:

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Tab Status Icons

As you are working through the tabs, each tab shows its current status. The status icons are as follows:

Everything on this tab is valid and in working order.

Something on this tab is not quite right. Youmight want to verify that you are not missing
anything. This does not make a profile invalid.

Example: There are no notifications selected.

There is an error on this tab. You will need to enter or correct information before this profile
can be used.

Example: There are publish destinations without encode settings selected.

Define Profiles Settings
In the Profile Settings tab, enter basic information about the profile.
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1. Enter a title for the profile.

Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

2. Enter a description.
3. Select the Transcription Settings.
4. Click Save.
5. Click thePublish Destination tab to continue.

Select Publish Destinations
In the Publish Destinations tab, you select the publish destinations you want to use for presentations proc-
essed with the profile.

1. Select one or more publish destinations from those available.

To create additional publish destinations, go toProfiles > Publish Destinations.

2. Click Save.
3. Click theEncode Settings tab to continue.

Select Encode Settings
In the Encode Settings tab, you select what kinds of encodings you want going to each of the previously
selected publish destinations.

1. Click to expand a publish destination, if needed.
2. Select the types of encodings you want to publish to that destination.

For information on the available encoding types, seeAvailable Encoding Settings.

If an encoding type has an XML file available to include, an XML symbol shows up after you enable the
encoding type.

3. Click XML to include an XML file with the processed presentation. For some publish destinations, XML
is required and is enabled automatically.
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For more information about this XML file, seePublish XML File with an Encoding.

4. Repeat for each publish destination.
5. Click Save.
6. Click thePublish Accounts tab to continue.

Select Publish Accounts
In the Publish Accounts tab, you select the account to use for each publish destination/encoding combination.

1. Click to expand a publish destination, if needed.
2. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.

You can:

Keep the selected account

Select another account

Select Use presenter account

This option allows presenters to enter their own credentials. Presenters will need to log in to the
Camtasia Relay website and enter their credentials.

Select Use default account

This option allows the profile to access the default account information at the time of profile proc-
essing. Youmay want to use this option if the default account information changes from time to
time.

If you want to use the same account for all encodings under a publish destination, you
can use the top level dropdown box to select the account.
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3. Repeat for each publish destination.
4. Click Save.
5. Click theNotification Selection tab to continue.

Select Notifications
In the Notification Selection tab, you select which notifications you want to use in the profile.

1. Select one or more notifications to use with the profile.

All configured notifications are shown for you to choose from.

You do not have to select a notification for the profile to be valid. If you choose to not
include notifications in the profile, the only way for a presenter or administrator to tell if a
presentation has finished processing is to go toPresentations page, locate the pre-
sentation, and view the status.

2. Click Save.
3. Click theNotification Assignment tab to continue.

Assign Notifications
In the Notification Assignment tab, you select the encodings you want to associate with each previously
selected notification. Each notification only includes information about the encodings associated with it.

1. Click to expand a notification, if needed.
2. Under each notification, all publish destination/encoding combinations for the profile are shown.
3. Select the encodings you want to assign to the notification.
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4. Repeat for each notification.
5. Click Save.
6. Click theVariable Definition tab to continue.

Define Profile Variables
In the Variable Definition tab, you define the value for any profile variables that are used in the profile. You
only need to fill in values if you have previously created and used a profile variable in another part of the profile,
such as a file path or notification.
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1. Enter a value for each profile variable used in this profile.

2. Click Save.
3. Click theAssociated Users tab to continue.

Associate Users
In the Associated Users tab, you select users to associate with the profile. This gives the selected presenters
access to the profile in the recorder.

1. In the Available Users list, click to select a presenter.

Presenters are shown in the list in the following format: Display Name (username). For example: Mary
Smith (m.smith)

To select multiple presenters, hold down eitherSHIFT orCTRL as you click.

2. Click Add to associate presenters with the profile.
3. If you would like to have this profile automatically associated with all new presenters as they are added

to Camtasia Relay, enable theAutomatically associate this profile with new users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > Sys-
tem Options > Auto Associate Profiles and enable theAutomatically associate
selected profiles with new users option. When you return to the Associated Users
tab of a profile, you will see the option.

4. Click Save.
5. Click theOverview tab to continue.

Review the Profile
In the Overview tab, you can see and review the setup of a profile.
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You can click the Information icon to access more information about one of the following:

Publish destinations
Publish accounts
Encode settings
Notifications

Presenters that are associated with this profile are able to see this same overview when they
log in to the website.

When you have reviewed the profile setup, click theProfile Test tab to continue.

Test the Profile
In the Profile Test tab, you can process a sample presentation to verify that the profile behaves as you expect.

Camtasia Relay provides a pre-recorded presentation so you can test the behavior of the profile without hav-
ing to install the recorder and record a presentation.

1. Select a presenter to test the profile. This presenter's information is used, if needed, for variables,
accounts, etc.

Youmay want to make sure the presenter knows that you are going to test the profile, or use your own
presenter account.

The presenters available in the list are the users associated with this profile.

2. Select whether or not you want to test the notifications associated with the profile.
3. Select whether or not you want to include theHold for caption editing process in the profile test.
4. Click Test Profile.

Camtasia Relay submits a sample presentation and processes it with the settings of the profile.

5. You are redirected to thePresentations page where you can follow the progress of the presentation’s
processing.
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4. Add Users to Camtasia Relay
There are different ways to add users to Camtasia Relay.

If your organization:

Uses LDAP, seeAdd LDAP Users to Camtasia Relay.
Does not use LDAP, seeManually Add Users to Camtasia Relay.

After adding presenters, global caption editors, and other administrators, you shouldSet User Account Secu-
rity Settings.

Use More than One Kind of User

Camtasia Relay allows you to use both LDAP users and Camtasia Relay created users.

Some examples of why youmay want to use both LDAP and Camtasia Relay managed users:

You use LDAP and need a temporary account for a visiting presenter.
You use LDAP and need a presenter account for someone already in the system as an administrator.

Add LDAP Users to Camtasia Relay
If your organization uses LDAP, first you need toConfigure Relay to Use LDAP. After LDAP is configured,
then you can either set up Camtasia Relay toAutomatically Import Users with LDAP or you canManually
Import Users with LDAP.

You can have both LDAP and Camtasia Relay created users.

RelayPresenter Service Account

Prior to configuring Camtasia Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, Camtasia Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

Camtasia Relay never stores LDAP passwords with the exception of the password of this service account.

The service account should have a password that does not expire. Camtasia Relay will cease
to function for all users if the password of the service account in LDAP is not the same as the
password stored in the Camtasia Relay database.

Configure Relay to Use LDAP

1. Go toUsers > LDAP Configuration.
2. Click Configure LDAP.
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3. Enter server information:
Server address
Port

Use secure authentication: Select if you want to connect to the LDAP server over SSL.
Trust all certificates: Enable if you cannot connect over SSL due to an invalid certificate.
If you have a valid self-signed certificate, import the signing certificate into the Trusted
Root Certificate Authority on the Camtasia Relay Server for better security.
Authenticationmethod (Basic or Negotiate)

Username & password to authenticate
4. Click Next.
5. Select the returned base distinguished name or enter another.

Camtasia Relay returns the root of the LDAP directory, and pre-fills theBase distinguished name field.
Or, if you know exactly where your users reside in the LDAP directory, you canmanually enter the
Base distinguished name.

6. Click Next.
7. Select a representative user with the following attributes:

Full name
Username
Email address

We suggest adding a “RelayPresenter” user to the LDAP directory prior to configuring
Camtasia Relay to work with LDAP. SeeRelayPresenter Service Account.

8. Click Next.
9. Map the attributes from the selected user to the fields Camtasia Relay requires.

You can choose from the dropdown list of attributes returned from LDAP or type in an attribute if it is
not found in the dropdown list.

10. Click Next.
11. Review the configuration information.
12. Enter a valid username and password into the Test Authentication fields and click Test.
13. Click Finish.

You can now configure Camtasia Relay toAutomatically Import Users with LDAP orManually
Import Users with LDAP.

Automatically Import Users with LDAP

To ease administration of Camtasia Relay, you can enable a system option to import an LDAP user when
they log into Camtasia Relay (website or recorder) with valid LDAP credentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get Camtasia Relay set up when you use LDAP authentication.
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Automatically Add Users with LDAP

1. Go toSystem > System Options > Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the Camtasia Relay website or the Camtasia Relay recorder with
LDAP usernames and passwords, they are automatically added to Camtasia Relay. If you enabledAuto
Associate Profiles, presenters can access the selected profiles immediately. This is a great way to reduce
the amount of administration work for getting new users started with Camtasia Relay.

Manually Import Users with LDAP

Camtasia Relay can reference an LDAP directory to populate the user database. There are two ways to
import users into the Camtasia Relay database.

At the end of the LDAP setup wizard, click Manually import Users to import users immediately.
When LDAP is enabled you can also import users from theUsers > LDAP Import page.

You can use search criteria, such as username, name, email, or LDAP attributes, to find users to add to Cam-
tasia Relay.

Manually Add Users to Camtasia Relay
If you do not use LDAP for authentication, you can create users manually in Camtasia Relay.

You can have both LDAP and Camtasia Relay created users. SeeMore than One Kind of
User.

Create a New User

1. Go to theUsers page.
2. Click theNew User link.

3. Enter a username.

This is the username the presenter uses to log in to the Camtasia Relay website and recorder.

4. Enter the name (given name) of the user.
5. Select Presenter orGlobal Caption Editor from the Access Level dropdown list.

NoAccess restricts the user from logging into the website and Recorder. For example,
you can use it to turn off a presenter’s privileges at the end of a semester/term.

6. Enter the user’s email address.
7. Enter and confirm a password.
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8. Click Save, or you can click Save & Add to immediately add another user.

Set User Account Security Settings
To help secure Camtasia Relay, you can set the following:

Recorder Security Settings
Forgot Password Settings
Account Lockout Settings
Password Complexity

Activate / Deactivate Camtasia Relay Server
Activate Camtasia Relay server to remove the trial period and activate the correct number of encoding proc-
essors. It is important to deactivate Camtasia Relay server before you uninstall the server so you can install
Camtasia Relay on another server.

To communicate with the activation server through a firewall, port 80must be open.

Activate the Camtasia Relay Server

1. Click System > Activation.
2. Enter your license code and click Activate.

Obtaining More Activations

If you find that you need additional activations for your server, please contact a sales associate at 1-800-517-
3001 (US) or 1-517-381-2300 x636 (international) and wewill walk you through the process of updating your
license.
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Offline Activation/Deactivation

If Camtasia Relay is installed on a private network, offline activation/deactivation allows you to deactivate
without connecting to the Internet.

Activate when offline

1. Log in to the Camtasia Relay website as an admin and go toSystem > Activation.
2. Click Offline Activation.
3. A window opens and contains an Installation ID number.
4. Contact a TechSmith sales associate at 1-800-517-3001 (US/Canada) or 1-517-381-2300 x636 (inter-

national).
5. Provide the Installation ID and License code to the sales associate. The sales associate gives you an

Unlock Code.

Your license code was emailed in the Camtasia Relay purchase receipt.

6. Enter the code into the field provided. Camtasia Relay is now activated.

To deactivate when offline

1. Log in to the Camtasia Relay website as an admin and go toSystem > Activation.
2. Click Offline Activation.
3. A window opens. Click Deactivate to deactivate the server.
4. The window closes and you return to page. The server is now shown in an Expired state.
5. Contact a TechSmith sales associate at 1-800-517-3001 (US/Canada) or 1-517-381-2300 x636 (inter-

national).
6. Provide the Proof of Removal code and the Installation ID to the sales associate. This decrements the

number of activations on your license code in the event that you want to activate a different server.

Problems with Activation/Deactivation

In the event of hardware failure or problems, please contact TechSmith.

US and Canada: +1-800-517-3001

International: +1-517-381-2300 x636

Please be ready with your Installation ID, License code or (orProof of removal code in the case of deac-
tivation). Your license code was emailed in the Camtasia Relay purchase receipt.

Verify Setup
The purpose of this step is to ensure everything is set up properly. It also helps you better understand the “big
picture” of Camtasia Relay and should help youmake better decisions when implementing Camtasia Relay
on a large scale.

Verify the Installation

1. Add yourself as a userwith presenter access. (Administrators cannot make recordings.)
2. Associate your presenter account to a profile.
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3. Download a recorder from System > Download Recorders and install. (It is recommended to not
install the Camtasia Relay recorder on the server as ameans of verifying your setup.)

4. Log in to the Camtasia Relay recorder. Enter the presenter account username and password created
on the Camtasia Relay website (e.g. don’t use the RelayAdmin username).

5. Select a profile.
6. Record your desktop activity for aminute or two. Stop the recording and click Submit.
7. Sign in to the Camtasia Relay website using the same username and password you entered into the

recorder. You can view the status of your recording and experience the website from a presenter point
of view.

8. Verify that the presentation processes and publishes correctly.

Roll-Out Camtasia Relay
Here’s a checklist of suggested steps when introducing Camtasia Relay to presenters.

Verify all presenters have valid profiles associated with their accounts.
Youmight wish to roll-out Camtasia Relay in stages. For example start with one department instead of
the whole company or campus.
What training do presenters require? You can direct presenters to the overview video launched from the
helpmenu of the recorder and the videos located in the help section of the Camtasia Relay website.
(Administrators see a different help page.)
Decide if you will install the Camtasia Relay recorder on user computers, if you will direct users to
obtain and install the recorder on their own, or if you will Deploy Camtasia Relay Recorder. The
recorder has the Camtasia Relay server URL “baked-in” based on the server from which it was down-
loaded. If you put a copy of the Camtasia Relay recorder on a website or network drivemake sure you
got it from the server you want people to use.
Establish a clear policy for how presenters should do things like request new profiles or profile changes
or request a new password.
Prepare an introduction email for presenters. We’ve created a few samples you canmodify.

See also

What Presenters Need to Know Most
Sample Emails Administrators Can Modify and Send to Presenters

What Presenters Need to Know Most
You need to communicate the following to presenters. You can use this information in an email introducing
Camtasia Relay to your presenters.

There are helpful videos

Get presenters to watch the overview accessible from the login screen of the recorder and in the Help section
on the Camtasia Relay website. Youmay want to send presenters directly to the video so they can review
Camtasia Relay before accessing the Recorder or having to sign in to the Camtasia Relay website.

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Make a test recording

There’s a blue TEST button in the Camtasia Relay recorder presenters can use to verify they are recording the
correct screen and that audio is recording properly. Nothing is worse than recording an hour presentation with
no audio.

How uploading works

As soon as the presenter clicks theSubmit button in the recorder, the recording gets ready to upload in the
background.

There is no visual indication of progress.
If the recorder is offline (or loses Internet access), the recording automatically uploads (or resumes
uploading) as soon as the computer gains Internet access.
Presenters receive an email when the presentation is published.
Presenters can check the upload, encoding and publishing progress if they log in to the Camtasia
Relay website.

Sample Emails Administrators Can Modify and Send to Presenters
Email examples for:

Presenters Integrated with Your LDAP System
Presenters Not Integrated with Your LDAP System
Presenters That Must Supply Publish Destination Account Information

Presenters Integrated with Your LDAP System

Subject: Your Camtasia Relay Account andGetting Started Information

Body: Greetings! This email contains everything you need to know to start recording presentations with Cam-
tasia Relay. Use Camtasia Relay on your computer to record whatever is on your screen—PowerPoint, Key-
note, websites, etc. Once you submit the recording, our Camtasia Relay server will process the file and
publish the presentation in a variety of formats in convenient locations.

Where to start?

Watch this video: It’s very short and you’ll see the entire Camtasia Relay process.
Camtasia Relay requires a username and password. Good news! You don’t have to remember yet
another password. Use the same username and password you use to access our [work, school, uni-
versity] network.
Install Camtasia Relay [either direct users to the Camtasia Relay website or make the installer avail-
able in some other manner].

Questions? Problems?

Please direct all questions and feedback to the Camtasia Relay Administrator.

Name:

Email:

Phone:

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Presenters Not Integrated with Your LDAP System

Subject: Your Camtasia Relay Account andGetting Started Information

Body: Greetings! This email contains everything you need to know to start recording presentations with Cam-
tasia Relay. Use Camtasia Relay on your computer to record whatever is on your screen—PowerPoint, Key-
note, websites, etc. Once you submit the recording, our Camtasia Relay server will process the file and
publish the presentation in a variety of formats in convenient locations.

Where to start?

Watch this video: It’s very short and you’ll see the entire Camtasia Relay process.
Camtasia Relay requires a username and password.

Your username is:
Your password is:
You can change your password by signing into the Camtasia Relay website [URL here] and
clicking theAccountsmenu.

Install Camtasia Relay [either direct users to the Camtasia Relay website or make the installer avail-
able in some other manner].

Questions? Problems?

Please direct all questions and feedback to the Camtasia Relay Administrator.

Name:

Email:

Phone:

Presenters That Must Supply Publish Destination Account Information

For example, presenters need to enter usernames and passwords to a network drive, personal FTP site or
Screencast.com account.

Subject: Please supply account information for Camtasia Relay

Body: Your Camtasia Relay account is all set up and almost ready to go. There’s just one last step. In order to
publish your presentations, you need to enter your username and password for [publish destination].

To enter your account information:

Sign in to the Camtasia Relay website [URL].

You will immediately see a yellow “Action Required” banner with a link to the account with missing infor-
mation. Click the link and enter your information.

Questions? Problems?

Please direct all questions and feedback to the Camtasia Relay Administrator.

Name:

Email:

Phone:

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Deploy Camtasia Relay Recorder
In a locked-down or controlled environment, the administrator can choose to deploy the Camtasia Relay
recorder forWindow operating systems, instead of having the users download it from the Relay website.

TheWindows Installer client can be found on the server at:

[INSTALLDIR]_installhelper\CamtasiaRelayRecorder.msi

This MSI can be distributed via the usual methods; creating aWindows Installer Transform file or using the
command line switches. The "Properties" that need to be assigned values are as follows.

Critical Properties

PRIMARYENDPOINT: Camtasia Relay server URL.
TEAMID: TeamingGUID. This property should be only used when teamingmultiple servers together.

Optional Properties

INSTALLDIR: Main destination folder.
TSC_PP_ADDIN: Set to 0 to disable the Camtasia Relay recorder Add-in for Microsoft PowerPoint.
TSC_START_NOW: Set to 0 to keep Camtasia Relay recorder from launching after installation.
TSC_DESKTOP_LINK: Set to 0 to not create a shortcut to Camtasia Relay recorder on the Desktop.

Example

msiexec.exe /i “\\Apps_server\CamtasiaRelayRecorder.msi” PRI-

MARYENDPOINT="https://relaydev01.techsmith.com/relay/rest.ashx" TEA-

MID="FE47DE98-9E88-414b-A99F-C24F26951D7F" TSC_DESKTOP_LINK=0 /qb-!
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Camtasia Relay Administration Reference
The following topics provide reference information for Camtasia Relay administrators. Use these topics to find
out information about specific Camtasia Relay pages.

System Menu
Presentations Menu
Profiles Menu
Users Menu

System Menu
The Systemmenu allows you tomanage the Camtasia Relay system and view related options. The following
pages are available in this menu:

System
Servers
System Options
Plug-Ins
Activation
Client Machines
Event Log
Download Recorders

System
The System page contains information to help you configure Camtasia Relay and a Dashboard to provide a
quick overview of the system status at a glance.

Important Configuration Steps

This component of the System page contains the threemost important steps for configuring the Camtasia
Relay system:

Define Publish Destinations
Set Up Notifications
Create Profiles

For more information on configuration, seeConfiguration of Camtasia Relay.

Dashboard

The Dashboard provides you with a quick look at what is going on with the Camtasia Relay system. On this
page, you can find the following:
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Presentation Actions Necessary / Recent Presentations

If there are any actions you need to take to allow presentations to process, they show
here. For example, a presentation is uploaded using the Upload and Decide Later pro-
file.

Click an item in the list to go to the page where you can take action for that item.
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If there are no presentations that need action, this area shows a list of the tenmost
recent presentations.

Click a link to view information about the completed presentation, including links to the
published presentations, when available.

System Messages / Servers

This area alerts you of any important issues that you need to address in the Camtasia
Relay system.

If there are no alerts, the current count of various system components is displayed.

If you have invalid profiles indicated in the list, go to theProfiles page where the invalid
profiles are shownwith an error status in the profile list.

Encoder Usage

The Encoder Usage graph displays the peak encoder usage and average encode capac-
ity of a Camtasia Relay server. Peak encoder usage is themaximum number of queued
and processing encode jobs during that time period, while average encode capacity is
how often the encoder was busy during the time period.

If the time period is less than a week, the data is displayed by the hour.

If the time period is more than a week, the graph displays peak and average usage by
day. The average displayed for a day is the highest hour of that day. The entire time it
takes to process an encoding is tracked (including any time the encoding job is waiting
in the queue), but time spent uploading and captioning the presentation is not.

Use this chart to track peak usage times, see when the encoding server is at its
busiest, or to find out if the encoding server is overloaded and unable to process all the
presentations it receives in a timely manner.

Average File Size by Encoding

The Average File Size chart shows the average file size (in megabytes) per minute of
video for each encoding type used during the time period. The graph shows averages
across each group of encoding types, grouped by encode format. Clicking an encoding
group shows the average of each specific encode type.

Encode Speed / Recorded Minute

The Encode Speed graph shows the average time a presentation processed with a spe-
cific profile takes to encode, in minutes of encode time per minute of presentation
video. Themain view is the time from when the first encoding type begins until the last
encode type ends. Click a specific profile to see a breakdown of the encode speed for
each encoding type included in that profile.

Only the 10most used profiles appear on the Encode Speed graph.

System Panel

This area shows the current number of presentations, servers, profiles, invalid profiles,
presenters, and administrators.
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Servers
The Servers page contains information about and lets you interact with servers running Camtasia Relay.

If you havemultiple servers to handle processing presentations, you have a “teamed” server
environment. On the Servers page of each teamed server, you can access the other servers in
the team.

Server Status Icons

Icon Status Description

Online Currently accepting and processing presentations.

Offline Currently not accepting new presentations, but still processing exist-
ing presentations.

Shutdown Currently not accepting or processing presentations.
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Change Server Status

Take a server offline

When you take a server offline, the server stops accepting new presentations, but continues to proc-
ess presentations it has already received.

Shutdown a server

If you need to completely stop a Camtasia Relay server (to upgrade, for example) take the server off-
line and then wait until all jobs are Completed and click Shutdown.

Verify all presentations have completed prior to shutdown. Any presentations that are
not completed will be canceled. When the server is brought back online, all canceled
jobs are automatically retried.

Bring a server back online

When you are ready to bring the server back into service, select it from the server list and click Bring
Server Online.

System Options
System Options include:

Auto Associate Profiles
Auto Import Users
Portable Recorder Options
Email Notifications

Auto Associate Profiles

To ease administration of Camtasia Relay, you can choose specific profiles to automatically assign to new
users. Use this option when you want all presenters to have a common profile or set of profiles.

Profiles are only assigned to users when they are first added to Camtasia Relay. Changes
made to the automatically assigned profiles list are not reflected on existing Camtasia Relay
users.

Automatically Associate Profiles

1. Go toSystem > System Options > Auto Associate Profiles tab.
2. If needed, enable the option toAutomatically associate selected profiles with new users. (This

option is enabled by default.)
3. Select a profile in the dropdown list and click Add. Repeat to add all required profiles to the list.
4. Click Save.

Manage Auto Associate Setting for Single Profile

1. Go toProfiles.
2. Click a profile.
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3. Click theAssociated Users tab.

4. At the bottom of the page, enable or disable theAutomatically associate this profile with new
users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > System
Options > Auto Associate Profiles and enable theAutomatically associate selected pro-
files with new users option. When you return to the Associated Users tab of a profile, you
will see the option.

Other System Options

Auto Import Users
Portable Recorder Options
Email Notifications

Auto Import Users

To ease administration of Camtasia Relay, you can enable a system option to import an LDAP user when
they log in to Camtasia Relay (website or recorder) with valid LDAP credentials.

Use this option with automatically assigning profiles for the easiest way to get Camtasia
Relay set up using LDAP authentication.

Automatically Add Users with LDAP

1. Go toSystem > System Options >Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the Camtasia Relay website or the Camtasia Relay recorder with
LDAP usernames and passwords, they are automatically added to Camtasia Relay. If you enabledAuto-
matically Assign Profiles, the presenters can access the selected profiles immediately.

Other System Options

Auto Associate Profiles
Portable Recorder Options
Email Notifications

Portable Recorder Options

Administrators can decide how they would like presenters to access the portable recorder. Choose from the
following:
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Option Description

Available
by down-
load only

The portable recorder is available on the website.

Presenters can log in to the website and download the portable recorder and
transfer it to amobile storage device, such as a USB drive.

Use this option if presenters are reasonably “technical” and understand down-
loading and unzipping files.

Available
by email
request
only

There is a button available on the website to request a portable recorder.

Presenters can log in to the website and click this link to send an email request to
the administrator. The administrator receives an email with the request.

Use this option if presenters are “not technical” andmay not understand down-
loading and unzipping files. You can put the portable recorder on amobile storage
device and give it to the presenter.

Not avail-
able

There is no way for a presenter to download or request a portable recorder.

Use this option if you will handle distributing all portable recorders or do not want
to use the portable recorder in your organization.

Even if they do not have access to the portable recorder, presenters are still able
to find information about it in the help and other locations.

For information about how to upload presentations from a portable recorder, seePortable Recorder.

Other System Options

Auto Associate Profiles
Auto Import Users
Email Notifications

Email Notifications

With installation and initial configuration of Camtasia Relay, you are asked to provide email server infor-
mation. You can also choose to enable or disable email notifications from Camtasia Relay.

These notifications includemessages directly from the system:

Password changes
Trial expiration
Server disk space warnings
Presentations needing attention
Presentations held for captioning

This option does not affect any profile notifications.

To update your email notification setting:
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1. Go toSystem > System Options > Email Notification tab.
2. Enable or disable theEnable email notifications option.
3. Click Save.

Other System Options

Auto Associate Profiles
Auto Import Users
Portable Recorder Options

Send Usage Data

By default, the Send Usage Data option is enabled. This means that anonymous information about your hard-
ware and the usage of Camtasia Relay is sent, securely, to TechSmith. No personal information about your
organization or presenters is sent.

To disable this option, uncheck Automatically sends usage data to TechSmith.

To see the actual data being collected, use the Information Gathering Application. The Information Gathering
Application is located here: C:\Program Files\TechSmith\Relay Server\Ma-
nager\InfoGathering.exe

Formore on the type of information collected, see the help file included in the Information Gathering Appli-
cation.

Plug-Ins
Plug-ins aremodules that you can install to add additional publish destinations or notification options to Cam-
tasia Relay. Camtasia Relay comes with various plug-ins available to install for both publish destinations and
notification servers:

Name Plug-In Type Installed by Default?

Blackboard Notification No

Email Notification Yes

Moodle Notification No

Amazon S3 Publish Destination No

Drupal Publish Destination No

File System Publish Destination Yes

FTP Server Publish Destination Yes

iTunes U Publish Destination No

Kaltura Publish Destination No

Mediasite Publish Destination No

Screencast.com Publish Destination Yes
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Name Plug-In Type Installed by Default?

Microsoft Windows SharePoint Publish Destination No

WebDav Publish Destination No

YouTube Publish Destination No

The list of plug-ins that are installed by default is for a new installation. When upgrading from a
previous version of Camtasia Relay, any plug-ins that were installed prior to the upgrade are
still available.

Additional plug-ins may periodically become available. Instructions to add a new plug-in to your server will be
provided with the plug-in.

See also

Install a Plug-In
Remove a Plug-In

Install a Plug-In

Before a plug-in is available to use, youmust first verify and install the plug-in.

1. Once a plug-in is available on your server, go toSystem > Plug-Ins.
2. Locate the plug-in in the list and click Verify.

The Camtasia Relay server verifies that it can load the plug-in. Once the plug-in is verified, an Install
button appears.

3. Click Install.

If the plug in installs correctly, the button disappears.

4. Complete setup for the newly added plug-in:

Go toProfiles > Publish Destination Setup to access publish destinations.

Go toProfiles > Notification Server Setup to access notification servers.

See also

Remove a Plug-In.

Remove a Plug-In

Before you can remove a plug-in, it cannot be in use.

1. Go toSystem > Plug-Ins.
2. Determine if the plug-in is in use.

If the plug-in is not in use, there is aRemove button available for the plug-in.
If theRemove button is not available, check the following pages to see where the plug-in is in
use and delete any dependencies:
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Profiles > Publish Destination Setup
Profiles > Publish Account Setup
Profiles > Notification Server Setup
Profiles > Notification Setup

3. Click Remove.

The plug-in is removed from use but is not removed from the server. All files related to the plug-in are
still available on the server. The plug-in stays in the list and can be installed again.

See also

Install a Plug-In.

Activation
Activate Camtasia Relay server to remove the trial period and activate the correct number of encoding proc-
essors.

Whenmoving to a new server, it is important to deactivate Camtasia Relay server before you
uninstall the server so you can install Camtasia Relay on another server.

Activate/Deactivate the Camtasia Relay Server

1. Go to System > Activation.
2. Enter your License code and click Activate (or Deactivate).

Offline Activation/Deactivation

If Camtasia Relay is installed on a private network, offline activation/deactivation allows you to do so without
connecting to the Internet.

You can activate and deactivate Camtasia Relay server by contacting TechSmith by phone.

US and Canada please call: +1-800-517-3001
International please call: +1-517-381-2300 x636

Please be ready with your Installation ID, License code (orProof of removal code in the case of deac-
tivation). Your license code was emailed in the Camtasia Relay purchase receipt.

Assistance with Activation

In the event of hardware failure or problems, please contact TechSmith.

US and Canada please call: +1-800-517-3001
International please call: +1-517-381-2300 x636

Please be ready with your Installation ID, License code or (or Proof of removal code in the case of deac-
tivation). Your license code was emailed in the Camtasia Relay purchase receipt.

Client Machines
On the Client Machines page, you can view information about the client machines for the server. Use this infor-
mation to troubleshoot problems or verify that presenters download updated recorders, if needed.

You can view the following:
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Computer name
IP address
Client type (Windows or Mac)
Version of the Camtasia Relay recorder
Last connection
Last user to connect (with link to more information)
Last presentation information (with link to more information)
Diagnostic information (with link to download a log file)

Event Log
On the Event Log page, you can sort events to troubleshoot problems. Available information includes the fol-
lowing:

Type
Date/Time
Server
Source
Details

You can also filter the list based on:

Errors
Warnings
Messages
Sources

Download Recorders
Access and download all the Camtasia Relay recorders.

If you want to record a presentation, youmust have a presenter account. You cannot log in to
any of the Camtasia Relay recorders as an administrator.

When presenters download the recorder, any available plug-ins and add-ins are also installed on the pre-
senters’ computers:

Windows
Presenters are given the option in the Camtasia Relay recorder installer to install theCamtasia
Relay Add-In for Microsoft Office PowerPoint. This add-in allows a presenter to easily rec-
ord a PowerPoint slide show with Camtasia Relay from inside of PowerPoint. See the Cam-
tasia Relay recorder help for more information.
Presenters that are also running Camtasia Studio 5.1 and above are provided with a plug-in that
allows for sending a Camtasia Studio project to the Camtasia Relay server for production and
publishing. An option to produce with Camtasia Relay is added to the production process in
Camtasia Studio automatically when both programs are installed on the same computer.

Mac
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Presenters that are also running Camtasia for Mac 1.2 and above are provided with a plug-in that
allows for sending a Camtasia for Mac project to the Camtasia Relay server for production and pub-
lishing. An option to share with Camtasia Relay is added to Camtasia for Mac automatically when both
programs are installed on the same computer.

For information on the portable recorder, seePortable Recorder.

Portable Recorder

Provide the portable recorder to presenters if there is any reason that presenters cannot (or should not) record
and upload directly from the presentation computer. For example:

Presenters record on computers where they do not have permission to install applications.
Presenters record on computers that have limited or no network access.
You want to collect the presentations and upload them collectively at a later time.
You want to have presenters contact an administrator to receive a portable recorder.
You want to install the Camtasia Relay portable recorder on amobile storage device and distribute to
presenters.

You can select how you want presenters to access the portable recorder on theSystem Options page.

Create a Portable Recorder

Use the following process to install the portable recorder on amobile storage device, such as a USB flash
drive.

1. Plug in amobile storage device and format the device as FAT32.
2. Click Download Portable Recorder and save the ZIP file to your computer.
3. Locate and open PortableCamtasiaRelayRecorder.zip.
4. Copy all files from the ZIP file onto themobile storage device.

All files from the ZIP file need to be copied to the root of the device for the Camtasia Relay port-
able recorder to autorun onMicrosoft Windows operating systems.

Upload Presentations from a Portable Recorder

To upload presentations from a portable recorder:

1. Connect the portable recorder to a computer with the desktop version of the Camtasia Relay recorder
installed on it.

2. Make sure that the desktop Camtasia Relay recorder is not running and open the Camtasia Relay port-
able recorder.

3. Click theView Saved Presentations button.

4. The Saved Presentations dialog opens.
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5. Click Upload All to submit all of the presentations for upload or click to submit individual pre-
sentations.

You can submit saved presentations at any time.

If you are online and connected to the server, your presentations start to upload.
If you are offline, your presentations are stored on the computer and automatically upload to the server
once you are online and connected.

After you upload saved presentations, you cannot access or view your presentation or the
status of the upload in the Camtasia Relay recorder. You can check the status of the pre-
sentations on thePresentations page of the Camtasia Relay website.

Presentations Menu
The Presentations menu allows you to view andmanage presentations. The following pages are available in
this menu:
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Presentations
Job Status
History

Presentations
The Presentations page allows you to view presentations by state and take action to resolve issues.

Presentations in all states have the following information:

User name and email of presenter that submitted the presentation
Date and time the presentation was recorded
Computer name, with link to diagnostic information on theClient Machines page
Presentation description, if entered by the presenter
Profile used, with link to view and edit profile
Duration of presentation
Resolution of presentation

You can view presentations on the server by the following states:

States Description

Needs
Attention

Use the information and options provided to resolve issues so the presentation
can process. Includes a list of presenters and a list of profiles to select from. You
can also delete presentations.

Processing
View the progress of a processing presentation. You can see the progress of
each job associated with the presentation, including transcription, encoding, pub-
lishing, and notifications.

Uploading View the upload progress and cancel upload, if needed.

Completed View the status of presentations that have completed processing. For some pub-
lish destinations, links are included to view the published presentation.

Deleted View information about any deleted presentations.

Failed Use the information provided to figure out why a presentation failed. Includes
status information to show you which part of processing failed.

Held for
Captioning

View the presentations held for caption editing. When caption editing is complete
or to skip caption editing, click Release Hold to continue processing the pre-
sentation. Only presenters can edit captions; administrators can only release a
hold.

Job Status
The Job Status page allows you to view and sort jobs on the Camtasia Relay server or teamed servers. You
can filter jobs by the following:

Status
Queued
Processing
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Failed

For failed jobs, expand the presentation information to resubmit or delete the pre-
sentation.

Canceled
Pending

Type
Encoder
Publisher

Server
All servers
Specific server

History
The History page allows you to view the history of Camtasia Relay presentations. You can do the following
with the items on this page:

Item Description/Action

Presentation
Title

Click to expand and view more information on the presentation. Includes profile,
client machine, processing progress, andmore.

Presenter The username of presenter that recorded the presentation. Click the username
to view more information about the presenter.

Server The name of the server processing the presentation. Click to view the status of
the server.

Recording
Date/Time Date and time that the presentation was recorded

Presentation
Status

Icons show the status of the presentation.

Uploading

Processing

Complete

Needs Attention

Failed

Deleted

Jobs
Queued

Jobs Proc-
Icons show the status of jobs for the presentation.
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Item Description/Action

essing

Jobs Can-
celed

Uncover More Information

You can drill down to findmore information on the presentations by expanding the presentation information
and clicking available links.

For example, if you’d like to see information about the source recording files for a presentation, you could:

1. Click a presentation to expand the available information.
2. Click the down arrow to expand an encoding action from the list.
3. Click View Encoding Files.

4. A new browser tab or page opens to show you information about the source files and the files produced
during encoding. Use this information for testing or troubleshooting.
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Profiles Menu
The Profiles menu allows you to create andmaintain profiles and related items. The following pages are avail-
able in this menu:

Profiles
Publish Destination Setup
Publish Account Setup
Notification Server Setup
Notification Setup
Variables

Profiles
Profiles are the backbone of Camtasia Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profile setup involves settings and information found on the following tabs:

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Information about Profiles

Upload and Decide Later Profile

The Upload and Decide Later Profile uploads the recorded presentation to the Camtasia Relay server
but the recording is not encoded or published. An authorized presenter or Camtasia Relay administrator
must assign a different profile and submit the recording for publishing via the Camtasia Relay website.

Why use the Upload and Decide Later Profile?

For guest presenters, it is the only profile available.
Youmake a presentation in advance, but do not want it published until later.
You are not satisfied with existing profile options and wish to hold the recording on the server
until you can contact your Camtasia Relay administrator to create or modify a profile.

Tab Status Icons

Each tab shows its current status. The status icons are as follows:

Everything on this tab is valid and in working order.
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Something on this tab is not quite right. Youmight want to verify that you are not
missing anything. This does not make a profile invalid.

Example: There are no notifications selected.

There is an error on this tab. You will need to enter or correct information before this
profile can be used.

Example: There are publish destinations without encode settings selected.

Create a New Profile

To create a new profile:

1. Go toProfiles.
2. Click theNew Profile button.

The Profile Setup page opens.

3. Work through, from top to bottom, the tabs at the left side of the page.

Profile Settings

In the Profile Settings tab, you enter some basic information about the profile.

1. Enter a title for the profile.

Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

2. Enter a description.
3. Select the Transcription Settings.
4. Click Save.

See also

Transcription Options
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test
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Transcription Options

Camtasia Relay provides an optional transcription process that allows you to include a full audio search, cap-
tions, or both in presentations. The available options are:

No transcription

Presentation audio is not transcribed.

Captions and full audio search

Presentation audio is transcribed for captions and full audio search in Flash and Silverlight encodings.
Choose one of the web or Silverlight encoding options to make this available for viewers.

When audio transcription is complete, the presentation is put into a Held for Captioning state on the Pre-
sentations page. There the presenter can review and edit the transcribed audio and release the hold to
continue processing the presentation.

Full audio search only

Presentation audio is transcribed to provide a full audio search in Flash and Silverlight encodings, but
no captions are shown in the presentation.

If you want to publish a different encoding type, you can still gain some benefits from transcription. For
example, enable the XML file (when available) to make the transcribed audio available as metadata in
the file. You can use this metadata for other uses, such as searching within amedia server.

Can be captioned by Presenter only

Presentation captions can only be edited by the presenter who uploaded the presentation.

Can be captioned by Presenter and Global Caption Editors

Presentation captions can be edited by the presenter who uploaded the presentations or any
Global Caption Editor.

The transcription process adds time to presentation processing.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test
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Publish Destinations

On the Publish Destinations tab, you select the publish destinations you want to use for presentations proc-
essed with the profile.

1. Select one or more publish destinations from those available.

To create additional publish destinations, go toProfiles > Publish Destinations.

2. Click Save.

See also

Publish Destination Setup
Publish Account Setup
Profile Settings
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Encode Settings

On the Encode Settings tab, you select what kinds of encodings you want going to each of the previously
selected publish destinations.

1. Click to expand a publish destination, if needed.
2. Select the types of encodings you want to publish to that destination.

For information on the available encoding types, seeAvailable Encoding Formats.

If an encoding type has an XML file available to include, an XML symbol shows up after you enable the
encoding type.

3. Click XML to include an XML file with the processed presentation. For some publish destinations, XML
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is required and is enabled automatically.

For more information about this XML file, seePublish XML File with an Encoding.

4. Repeat for each publish destination.
5. Click Save.

Available Encoding Settings

The table below contains descriptions of the encoding formats available in Camtasia Relay. TheMP4
with Smart Player encoding is recommended for use inmost situations. This setting utilizes the TechSmith
Smart Player to create an output with a Flash player that includes an HTML5 fallback. The Smart Player plays
great on desktop browsers, on iPhones and iPads, and onmany other mobile devices that support MP4 video.
It supports Table of Contents, Speech to Text, and Closed Captioning.

If transcription is enabled on the Profile Settings tab, youmust include a Flash or Silverlight
encoding format or include an XML file with the encoding to utilize the transcribed audio.

Preset Format
Includes
Camera
PIP?

Description

AVI (Original
Size) AVI Yes

This encode setting produces a single AVI file
with the same resolution as the original record-
ing. Use this file if you want to perform your own
video processing and encoding. Note that AVI
files usually have a larger file size than pre-
sentations encoded in other formats.

Camtasia Studio
Recording

(Original size)
CAMREC Yes

This encode setting generates a CAMREC file
for use with Camtasia Studio versions 5.1 to
7.1. The CAMREC file contains PowerPoint
and Keynote slide and title clip markers. This
encoding should only be given to presenters
with access to Camtasia Studio.

When publishing a CAMREC file to a location
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Preset Format
Includes
Camera
PIP?

Description

with a valid web URL, the resulting notification
includes a “View” link. Because web servers do
not have aMIME type set up for CAMREC
files, the link leads to a 404 error page.

Camtasia Studio
8.0 and Later
Recording

(Original size)

CAMREC Yes

This encode setting generates a CAMREC file
for use with Camtasia Studio version 8.0 and
later. The CAMREC file contains PowerPoint
and Keynote slide and title clip markers. This
encoding should only be given to presenters
with access to Camtasia Studio.

When publishing a CAMREC file to a location
with a valid web URL, the resulting notification
includes a “View” link. Because web servers do
not have aMIME type set up for CAMREC
files, the link leads to a 404 error page.

Camtasia for
Mac Recording

ZIP >
CMPROJ No

This encode setting generates a lossless video
file for editing within Camtasia for Mac. This
encoding should only be given to presenters
with access to Camtasia for Mac.

The resulting file is a ZIP file that, when opened
on aMac, automatically unzips into a directory.
The user can double-click that directory to
launch the CMPROJ in Camtasia for Mac.

iPad MP4 Yes

This encode setting creates video files with var-
ied final resolutions to provide the best viewing
experience for a given video on an iPad. The res-
olution is calculated to provide the best res-
olution to view the video at 10 frames per
second.

iPod and iPhone MP4 Yes

This encode setting works on all iPods and
iPhones that support video of any kind. The final
resolution of the video is fixed at 640 x 480.
Video looks good on all iPods and iPhones, but
does not look good if played in QuickTime on a
desktop computer.

MP3 MP3 No

This is an audio-only encode setting. The server
can process this encoding extremely fast, and
the resulting file size is small. This is a good
encode setting for those whomay want an
audio-only version of their presentation.
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Preset Format
Includes
Camera
PIP?

Description

MP4with Smart
Player

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

MP4 Yes

This encode setting creates anMP4 video file
that is displayed in a Flash controller file (SWF)
called the TechSmith Smart Player. Additional
files are created to provide an HTML5 fallback
player in cases where Flash is not available.

The Smart Player plays great on desktop
browsers, on iPhones and iPads, and onmany
other mobile devices that support MP4 video.
The Smart Player supports a table of contents
based on the titles of slides in a PowerPoint or
Keynote presentation, as well as slide text, full
audio search, and captions (if enabled).

MP4 (Original
Size) MP4 Yes

This encode setting creates anMP4 video file
with no additional files. The file is the same
dimensions as the original recording.

Original Record-
ing (Backup)

AVI (Win-
dows)

MOV (Mac-
intosh)

Recording
and cam-
era video
are save
as two
separate
files

This encode setting does not modify the original
recorded file in any way. The file size is enor-
mous and usually not considered viewer-
friendly. Use this setting if you need a copy of
original files for backup purposes or trou-
bleshooting.

Real Media

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

RMVB No
Generates a Real Media file. Can be used in
conjunction with Real Media servers, such as a
Helix Server.

Silverlight

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

XAP Yes

This encode setting creates video files that play
in Microsoft Silverlight. The controller supports
a table of contents based on the titles of slides
in a PowerPoint or Keynote presentation.

Also supports searching slide text, full audio
search, and captions, if enabled.
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Preset Format
Includes
Camera
PIP?

Description

(Original
Size)

Windows Media

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

WMV Yes

This encode setting creates video files that play
inWindows Media Player. The video files tend
to be larger than the Flash and Silverlight encod-
ings, but may be preferred by Windows users
with high speed internet access.

Windows Port-
able Media
Device

WMV No
This encoding is designed to provide the best
solution forWindows Mobile Devices (Pocket
PCs) and someWindows-based Smartphones.

YouTube MP4 Yes

This encoding is only available
for the YouTube publish des-
tination.

This is used for publishing directly to YouTube
using the YouTube publishing plug-in.

The video is subject to YouTube's restrictions.

Publish XML File with an Encoding

Camtasia Relay provides administrators with the option to generate XML files for published presentations. For
some publish destinations, XML is required and is enabled automatically.

The XML data contains information about the presentation such as the title, length, format, resolution, and
more. When you enable the transcription process inProfile Settings, the XML also contains the transcription
of the presentation audio.

Customers may use the XML file with existingmedia-hosting solutions, content delivery methods such as
RSS feeders, etc. TechSmith provides the XML data as a service, but does not support how the institution
uses the XML file.

XML data is available for all encode types and all supported publish destinations with the following excep-
tions:
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XML is not included with presentations published to iTunes U.
XML data is parsed into fields (as opposed to a single XML file) for presentations published to Screen-
cast.com. Themetadata can be found under Details when viewing a presentation on Screencast.com.

Information Included in the XML File

Presentation information: title, description, date, duration, and resolution
Profile used to create presentation
Presenter name
Client (computer used tomake the recording) IP address, and computer name
Server namewhere recording was processed
Encoding preset used
Length of time the presentation was in the queue for processing
Length of time it took to encode the presentation
Destination URL of published presentation

See also

Profile Settings
Publish Destinations
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Publish Accounts

In the Publish Accounts tab, you select the account to use for each publish destination/encoding combination.

1. Click to expand a publish destination, if needed.
2. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.

You can:

Keep the selected account
Select another account
Select Use presenter account

This option allows presenters to enter their own credentials. Presenters need to log in to the
Camtasia Relay website and enter their credentials.

Select Use default account

This option allows the profile to access the default account information at the time of profile proc-
essing. Youmay want to use this option if the default account information changes from time to
time.
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If you want to use the same account for all encodings under a publish destination, you
can use the top level dropdown box to select the account.

3. Repeat for each publish destination.
4. Click Save.

See also

Publish Account Setup
Publish Destination Setup
Profile Settings
Publish Destinations
Encode Settings
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Notification Selection

In the Notification Selection tab, you select which notifications you want to use in the profile.

1. Select one or notifications to use with the profile.

All configured notifications are shown for you to choose from.

You do not have to select a notification for the profile to be valid. If you choose to not
include notifications in the profile, the only way to tell if a presentation has finished proc-
essing is to go to Presentations page, locate the presentation, and view the status.

2. Click Save.
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See also

Notification Setup
Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Notification Assignment

In the Notification Assignment tab, you select the encodings you want to associate with each previously
selected notification. Each notification only includes information about the encodings associated with it.

1. Click to expand a notification, if needed.
2. Under each notification, all publish destination/encoding combinations for the profile are shown.
3. Select the encodings you want to assign to the notification.

4. Repeat for each notification.
5. Click Save.
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See also

Notification Setup
Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Variable Definition
Associated Users
Overview
Profile Test

Variable Definition

On the Variable Definition tab, you define the value for any profile variables that are used in the profile. You
only need to fill in values if you have previously created and used a profile variable in another part of the profile,
such as a file path or notification.

1. Enter a value for each profile variable used in this profile.

2. Click Save.

See also

Variables
Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
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Notification Assignment
Associated Users
Overview
Profile Test

Associated Users

On the Associated Users tab, you select users to associate with the profile. This gives the selected pre-
senters access to the profile in the recorder.

1. In the Available Users list, click to select a presenter.

Presenters are shown in the list in the following format: Display Name (username). For example: Mary
Smith (m.smith)

To select multiple presenters, hold down eitherSHIFT orCTRL as you click.

2. Click Add to associate the presenter with the profile.
3. If you would like to have this profile automatically associated with all new presenters as they are added

to Camtasia Relay, enable theAutomatically associate this profile with new users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > Sys-
tem Options > Auto Associate Profiles and enable theAutomatically associate
selected profiles with new users option. When you return to the Associated Users
tab of a profile, you will see the option.

4. Click Save.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Overview
Profile Test

Overview

On theOverview tab, you can see and review the setup of a profile.

You can click the Information icon to access more information about one of the following:

Publish destinations
Publish accounts
Encode settings
Notifications
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Presenters that are associated with this profile are able to see this same overview when they
log in to the website.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Profile Test

Profile Test

On the Profile Test tab, you can process a sample presentation to verify that the profile behaves as you
expect.

Basically, Camtasia Relay provides a pre-recorded presentation so you can test the behavior of the profile
without having to install the recorder and record a presentation.

1. Select a presenter to test the profile. This presenter's information is used, if needed, for variables,
accounts, etc.

Youmay want to make sure the presenter knows that you are going to test the profile, or use your own
presenter account.

The presenters available in the list are the users associated with this profile.

2. Select whether or not you want to test the notifications associated with the profile.
3. Select whether or not you want to include theHold for caption editing process in the profile test.
4. If you choose not to send notifications, you can view the status of the sample presentation on thePre-

sentations page.
5. Click Test Profile.

Camtasia Relay submits a sample presentation and processes it with the settings of the profile.

6. You are redirected to thePresentations page where you can follow the progress of the presentation’s
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processing.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview

Publish Destination Setup
Camtasia Relay can publish presentations to one or more of the following locations. Click the publish des-
tination type to learnmore.

File System (Network drives, etc)
FTP Server (FTP & sFTP)
Screencast.com (TechSmith’s media-hosting service)
WebDAV
Microsoft Windows SharePoint
iTunes U (Camtasia Relay formats supported by iTunes U includeMP4 andMP3)
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

If the publish destination you would like to use is not available in the list of publish
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destinations, youmay have to install the appropriate plug-in before you can use it. See Plug-
Ins for more information.

Publish to Amazon S3

To create an Amazon S3 publish destination:

1. Click Profiles > Publish Destinations.
2. Click Amazon S3 on the left to create a new destination.
3. Enter a title, the Amazon Access Key, and Amazon Secret Key.

The access key and secret key are provided by Amazon.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

AmazonWeb Services, the “Powered by AmazonWeb Services” logo, and Amazon S3 are trademarks of
Amazon.com, Inc. or its affiliates in the United States and/or other countries.

See also

File System
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube

Publish to Drupal

Camtasia Relay currently supports release 6.1 and 7 of Drupal. The Camtasia Relay Drupal
plug-in has been tested with version 6.1.9 and version 7.2.

1. Click Profiles > Publish Destinations.
2. Click Drupal on the left to create a new destination.
3. Enter all required information and select FTP and XMLRPC protocol options.
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4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
YouTube
Amazon S3

Publish to File System

To create a file system publish destination:

1. Go toProfiles > Publish Destination Setup.
2. Click File System on the left to create a new destination.
3. Enter all required information. Use variables to help createmulti-purpose publish destination paths and

URLs, as needed.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

FTP Server
Screencast.com
WebDAV
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Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to FTP Server

To create an FTP (or sFTP) publish destination:

1. Click Profiles > Publish Destinations.
2. Click FTP Server on the left to create a new destination.
3. Enter all required information. Use variables to help createmulti-purpose publish destination paths and

URLs, as needed.
Use the dropdown to select from :

http
https
mms
rtmp
rtsp

Use the dropdown to select between FTP or sFTP protocol.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3
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Publish to iTunes U

1. Click Profiles > Publish Destinations.
2. Click iTunes U on the left to create a new destination.
3. Enter all required information.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

iTunes U Publishing Requirements

Camtasia Relay can publish presentations directly to iTunes U provided the following conditions are satisfied:

Your institution has an iTunes U account. TechSmith is not affiliated with iTunes U.
The published presentations are encoded into a file type supported by iTunes U. Camtasia Relay offers
MP4, andMP3. (iTunes U supports M4A, MP3, MP4, M4V, MOV, and PDF.)
You know the Shared Secret code provided to your school by Apple. This is a 32 character alpha-
numeric code.
You have access to desiredMedia Group ID codes. These are 10-digit numbers that direct the
producedmedia into a specific instructor’s class. Learn how to find your Media Group ID.
Viewers need iTunes on their computers.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to Kaltura

Camtasia Relay can automatically publish presentations to Kaltura and KalturaMediaSpace™.
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Custom Data in Kaltura

To allow Camtasia Relay to publish to Kaltura, your Kaltura account must have Custom Data enabled. To ver-
ify this option is enabled, log in to your Kaltura administrator account and go to Settings.

If you do not see a Custom Data tab under Settings, please contact Kaltura support.

Configure Camtasia Relay to Publish to Kaltura

1. Go toProfiles > Publish Destinations.
2. Click Kaltura on the left to create a new destination.
3. Enter a title for the publish destination.
4. Enter the Service URL.
5. Enter the Partner ID and Administrator Secret.

To locate this information, log in to the KalturaManagement Console and go toSettings > Integration
Settings.

6. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination. SeeKaltura Publish Accounts for additional information.

7. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Mediasite
Drupal
YouTube
Amazon S3

Publish to Mediasite

Camtasia Relay currently supports and has been tested with release 5.5 of Mediasite.

1. Click Profiles > Publish Destinations.
2. Click Mediasite on the left to create a new destination.
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3. Enter all required information and select the FTP protocol option.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Drupal
YouTube
Amazon S3

Publish to Screencast.com

To create a Screencast.com publish destination:

1. Click Profiles > Publish Destinations.
2. Click Screencast.com on the left to create a new destination.
3. Enter a default folder. You can use variables to help automatically personalize the folder name.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

What is Screencast.com?

Screencast.com is the place to share your high-quality videos, documents, presentations, and images—
simply and professionally. We never compress or alter your content...so what you upload is what viewers
see. And with four levels of privacy controls, you get to decide who sees what.

Benefits of Publishing to Screencast.com

Presenters can easily manage, organize, and delete their presentations.
Presenters can attach additional materials to the video. For example, a viewer can download notes, the
actual presentation slides, etc.
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Screencast.com is hosted by TechSmith and is helpful for customers with limited bandwidth and
media storage space.
Presenters can exercise individual control over how their content is protected.
Presenters can allow viewers to comment on their presentations. See http://www.sc-
reencast.com/answers for more information.

Presenter Accounts for Screencast.com

When publishing to Screencast.com, set the Publish Accounts to Use presenter account.

Every Camtasia Relay presenter needs a Screencast.com account. To obtain Screencast.com accounts,
visit http://www.screencast.com. Accounts are not created via Camtasia Relay.

By default, presentations are stored in the Camtasia Relay folder on Screencast.com. Camtasia Relay Admin-
istrators can createmultiple Screencast.com destinations for organizational purposes, and can also create
multiple folders for presenters. Presenters may also create their own folders on Screencast.com and assign
them to their profile.

Inform Presenters

Presentations are not published until presenters sign in to the Camtasia Relay website and enter their account
information. Ideally, introduce presenters to the Camtasia Relay website and have them enter their Screen-
cast.com information beforemaking recordings.

Presenters that make a recording and upload a presentation before the information is entered receive an email
with a hyperlink and instructions to solve the problem.

See also

File System
FTP Server
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to Microsoft Windows SharePoint

Microsoft® Windows® SharePoint™websites allow users to share information, collaborated on documents,
andmanagemedia.

For additional information about Microsoft Windows SharePoint, see the training portal at:
http://www.microsoft.com/learning/en/us/training/sharepoint.aspx.

To create a SharePoint publish destination:

http://www.screencast.com/answers
http://www.screencast.com/answers
http://www.screencast.com/answers
http://www.screencast.com/
http://www.microsoft.com/learning/en/us/training/sharepoint.aspx
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1. Go toProfiles > Publish Destination Setup.
2. Click SharePoint on the left to create a new destination.
3. Enter the SharePoint URL.
4. If you have an invalid certificate on your SharePoint server that is not currently trusted by your Cam-

tasia Relay server, enable the option to Trust All Certificates. This allows Camtasia Relay to ignore
any certificate errors and publish to the SharePoint server.

5. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
FTP Server
WebDAV
Screencast.com
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to WebDAV

WebDAV (Web-based Distributed Authoring and Versioning) provides a way tomanage files over HTTP. It
allows web server directories to display as folders on a local computer. WebDAV lets you use these folders
like any other folder on the local computer. The URL that you publish a presentation to is the same as the URL
you use to view the presentation.

For additional information about WebDAV, please seeWebDAV Resources online at www.we-
bdav.org.

To create aWebDAV publish destination:

1. Go toProfiles > Publish Destination Setup.
2. ClickWebDAV on the left to create a new destination.
3. Enter theWebDAV URL.

http://www.webdav.org/
http://www.webdav.org/
http://www.webdav.org/
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If you want to publish to a SharePoint server, youmust create a SharePoint publish
destination; you cannot use aWebDAV publish destination to send presentations to a
SharePoint server.

4. If you have an invalid certificate on yourWebDAV server that is not currently trusted by your Camtasia
Relay server, enable the option to Trust All Certificates. This allows Camtasia Relay to ignore any
certificate errors and publish to theWebDAV server.

5. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

File System
FTP Server
Screencast.com
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to YouTube

To create a YouTube publish destination:

1. Click Profiles > Publish Destinations.
2. Click YouTube on the left to create a new YouTube publish destination.
3. Enter a title and select a category that is applied to all videos published to this destination.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
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for more information.

Presenter Accounts for YouTube

YouTube accounts have a length limit for videos uploaded to unverified accounts. Be sure publish accounts
(either a default account or individual presenter accounts) are verified to ensure that videos uploaded through
Camtasia Relay will be accepted.

Videos that are longer than YouTube's length limit will be discarded by YouTube. To avoid losing videos that
YouTubemay reject, it is recommended that profiles publishing to YouTube also create a copy of the original
recording.

Before videos can be published to a YouTube account, that account must have a channel. For
more information on creating a channel for a YouTube account, see the documentation on You-
Tube.com.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
Amazon S3

Publish Account Setup
For each publish destination, you can define the accounts for Camtasia Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

See additional account information for iTunes U Accounts andKaltura Publish Accounts.

To Create a Publish Account

1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-
tinations you have set up.

2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
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4. If not a default account, select if you want toUse account information from default account. This
allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts

The following informationmight help you inmaking some decisions when creating your publish accounts.

You can let presenters enter their own information.

If you would like to use this option, you do not have to set up a publish account. Instead, you will select
toUse presenter accountwhen configuring a profile.

Each publish destination can have a default account.
This can be helpful in several ways:
You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.
If the default account for a publish destinationmay change from time to time, you can select
Use default accountwhen configuring a profile. You can then change which account is the
default account without having to change anything in the affected profiles. The profiles use the
currently selected default account for a given publish destination.

You can select different publish accounts for each publish destination/encode setting combination in a
profile.

iTunes U Accounts

Each iTunes U course requires aMedia Group ID. TheMedia Group ID is a 10-digit number supplied by Apple.
Each instructor usually has aMedia Group ID for each class.

1. Click the New account link.
2. Enter theMedia Group ID. The remaining fields are optional, but they can be helpful when assigning

iTunes U publish destinations to profiles.
3. Click Save. There is a delay as Camtasia Relay verifies the settings with iTunes U.
4. Add additional accounts as necessary. iTunes U will be available as a publish destination for encode

types supported by iTunes U.

What is My Media Group ID?

iTunes 11 and later

1. Log in to your iTunes U account in iTunes 11 or later as an administrator.
2. Click on the category you wish to retrieve theMedia Group ID from.
3. On the right side of the screen, click onUpload and Manage Files.
4. TheMedia Group ID is in the URL.
5. Paste the URL into a document. It will look similar to:
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https://deimos.apple.com/WebObjects/Core.woa/

BrowsePrivately/example.com.1927435401.01099125312

6. TheGroup ID is the last 10 digits in the URL, indicated in this example in bold (1099125312).

iTunes 10 and earlier

1. Click on a class in iTunes U.

2. Right-click the Videos tab and select Copy iTunes Store URL.

3. Paste the URL into a document. It will look similar to:

https://deimos.apple.com/WebObjects/Core.woa/

BrowsePrivately/example.com.1927435401.01099125312

4. TheGroup ID is the last 10 digits in the URL, indicated in this example in bold (1099125312).

Kaltura Publish Accounts

Accounts for Kaltura publish destinations define how presentations are published to Kaltura and KalturaMedi-
aSpace™.

1. Enter a Title for the publish account.

This title is meant to help administrators understand what a specific account is meant for during profile
creation. Try to use descriptive naming conventions for easy identification.

2. Select if you want to make the account the default account. See Things to Consider about Publish
Accounts for information about default accounts.

If not a default account, select if you want toUse account information from default account. This
allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

3. Enter the Creator for this account.

By default, the Creator field is filled in with the system variable PresenterUserName. This variable is
replaced with the presenter's user name associated with a presentation during publishing. This variable
is a great choice if user names are the same in both Camtasia Relay and Kaltura, as presentations will
automatically map to the correct Kaltura user.

4. Enter any Tags for this account, using commas to separate entries. Tags are searchable in Kaltura and
KalturaMediaSpace.

5. Enter any Categories associated with this account.Categories define where (which tab, hierarchy,
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etc.) a presentation is published on a KalturaMediaSpace site.
6. Click Save.

Notification Server Setup
You can configure notifications from three types of servers:

Email Server
Blackboard Server
Moodle Server

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

Email Server Configuration

You configure the email server when you first log into Camtasia Relay after installation.

If you need to later modify the email server information, go toProfiles > Notification Server Setup > Email
Server tab.

You can only have one email server configured in Camtasia Relay.

The configuration includes:

The SMTP email server address (Required)
The SMTP email server port (Required)
The name and email address that shows in the Reply To fields of email notifications

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

Blackboard Server
Moodle Server

Blackboard Server Configuration

Camtasia Relay can automatically post announcements on Blackboard. Configuring Blackboard announce-
ments is a two-step process. First, install the Camtasia Relay Building Block on Blackboard and establish the
Shared Secret. Next, configure Camtasia Relay to publish Blackboard announcements.
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The configuration steps vary depending on your version of Blackboard Learn™. Camtasia
Relay currently supports release 9.1. The Camtasia Relay Blackboard plug-in has been tested
with version 9.1.407.

Install Camtasia Relay Building Block

1. Locate the Camtasia Relay Building Block (RelayAnnounce.war) installed during the server instal-
lation at: C:\Program Files\Techsmith\Relay Server\Blackboard Building Block.

2. Go to your Blackboard site. E.g. http://blackboard.example.com.
3. Click User Login and sign in as a System Administrator.
4. Click theSystem Admin tab.
5. Click Building Blocks.

6. Click Installed Tools.
7. Click theUpload Building Blocks button.
8. Under Install Building Block, browse to RelayAnnounce.war. Click Open.
9. Click theSubmit button and verify the Building Block is available.

10. Click theSettings button. This displays the Shared Secret.
11. Choose and enter a secure Shared Secret, andmake a note of it as you need to enter the Shared

Secret into Camtasia Relay.

Configure a Blackboard Server

1. Go toProfiles > Notification Server Setup > Blackboard Server tab.

2. Enter a title (name) for the server.

3. Enter the Blackboard URL and Shared Secret.
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4. Click Save.

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

Email Server
Moodle Server

Moodle Server Configuration

Camtasia Relay can automatically post notifications on aMoodle server. ConfiguringMoodle notifications is a
two-step process. First, configure theMoodle server to receive the notifications; next, configure Camtasia
Relay to publish notifications toMoodle.

Configure a Moodle 2.0 or Later Server to Receive Notifications
Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Configure Camtasia Relay to Send Notifications to Moodle
Troubleshooting Sending Notifications to Moodle

The configuration steps vary depending on your version of Moodle. Camtasia Relay currently
supports version 2.0 and later and 1.9. The Camtasia Relay Moodle plug-in has been tested
with Moodle versions 1.9.5, 1.9.6, 1.9.7, and 1.9.9. Version 2.x has been tested with up to ver-
sion 2.2.

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

Email Server
Blackboard Server

Moodle 2.0 and Later Plug-In Setup

Enabling Camtasia Relay to send publish notifications to aMoodle 2.0 or later server requires two steps. This
topic covers the first, installing and configuring the plug-in on theMoodle server. The second is step is toCon-
figure Camtasia Relay to Send Notifications to Moodle.

Install the Camtasia Relay Plug-In on the Moodle Server
1. On your Camtasia Relay server, navigate to C:\Program Files\TechSmith\Relay

Server\Moodle Components\.



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - 71 -

2. Extract the camtasia_relay.zip file to your Moodle server in the {moodle_install_dir}
/server/moodle/local/ directory.

3. Log in to theMoodle website as an administrator and go to Home.
4. A prompt appears to upgrade the Camtasia Relay Notification plug-in. Click Update and then click

Continue to check for updates.
5. Go to Site Administration > Plugins > Web Services > External Services and verify the service shows

up in the Built-in Services List.

Configure the Camtasia Relay Plug-In on the Moodle Server
Log in to theMoodle site as an administrator. Next, Navigate to Site Administration > Plugins > Web Services
> Overview. The instructions in the overview describe how to configure the Camtasia Relay plug-in.

1. Enable web services.
2. Enable protocols. Enable XML-RPC andWeb Services Documentation.
3. Create a new user to act as the "Relay User." This user is used with the web service so Camtasia

Relay can access theMoodle server.
4. Check for user capability. The user should have appropriate capabilities according to the protocols

used. Use either an existing role or add a new Web Services role. To add a new role:
a. Go to Site Administration > Users > Permissions > Define Roles.
b. Add a new role.
c. Give the new role System and User context types.
d. Allow capabilities for this role.

i. Allow Web Service: XML-RPC protocol > Use XML-RPC protocol
ii. Allow Forum > Start New Discussions.

5. Add the new role to the "Relay User" account created earlier. Go to Site Administration > Users > Per-
missions > Assign User Roles

a. Click on theWeb Service or other role and assign to the "Relay User."
b. Go to Site Administration > Users > Permissions > Check System Permissions to verify that

the Relay User has the required capabilities.
6. Create a token for the Relay User.

a. Go to Site Administration > Plugins > Web Services > Manage Tokens.
b. Create a new token. Select "Relay User" and Camtasia Relay Notification Service and save

changes.
c. Record the newly created token string. This is the token used to set up a notification on the

Camtasia Relay website. It must be entered on the Camtasia Relay website when setting up
the publish notification.

To finish configuring the publish notification on the Camtasia Relay website, seeConfigure Camtasia Relay
to Send Notifications to Moodle.

See Also

Troubleshooting Sending Notifications to Moodle

Moodle 1.9.x Server Configuration

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
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Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

These steps may also work with Moodle versions prior to 1.9.5, but this has not been verified
by TechSmith Corporation.

To support Camtasia Relay notification integration, install a new PHP file, rpclib.php, on theMoodle
server as follows:

1. Locate and copy the following file:

C:\Program Files\TechSmith\Relay Server\Moodle Components\rpclib.php

2. Paste the file to theMoodle server at:

<IIS or apache-path>/htdocs/moodle/mod/forum/rpclib.php

3. Locate the following file on theMoodle server:

.../htdocs/moodle/lang/en_utf8/forum.php

4. Add the following lines to the forum.php:

$string['forum_add_discussion1_name'] = 'forum_add_dis-

cussion';

$string['forum_add_discussion1_description'] = 'calls forum_

add_discussion';

5. On theMoodle server, log in as an administrator.
6. Navigate toNetworking > XML-RPC hosts.
7. Enable theOn option and click Save changes.

8. Navigate toNetworking > XML-RPC hosts.
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9. Add the Camtasia Relay server IP address and, optionally, a network block to the list of trusted hosts.

Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
Moodle versions 1.9.7, 1.9.8, and 1.9.9 include several changes to the way networking and XML-RPC are han-
dled.

It is necessary tomakemanual updates to your Moodle database. This can be accomplished with phpMyAd-
min or MySQLCLI if you are usingMySQL; otherwise, use the appropriate utility for your database.

This procedure assumes you have a standard installation of Moodle.

1. Follow the steps used for 1.9.5 and 1.9.6.
2. Insert a new row intomdl_mnet_service to represent the forum announcement service.

id name description apiversion offer

The next highest value, for this
example, it is 4

forum
course announce-
ment service

1 1

3. Insert a new row intomdl_mnet_rpc to represent the forum announcement service.

Column Name Value

id The next highest value, for this example, it is 15

function_name forum_add_discussion_1
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Column Name Value

xmlrpc_path mod/forum/rpclib.php/forum_add_discussion1

parent_type forum

parent mnet

enabled 1

help Post amessage to a forum

profile blank

4. Insert a new row intomdl_mnet_service2rpc to link themdl_mnet_service record to themdl_mnet_
rpc record.

id serviced rpcid

The next highest value,
for this example, it is
15

The id entered into mdl_mnet_
service, for this example, it is
4

The id entered into mdl_
mnet_rpc, for this example, it
is 15

5. Insert a new row intomdl_mnet_host2service to link themdl_mnet_host record to themdl_mnet_serv-
ice record.

id hostid serviceid publish subscribe

The next
highest
value, for
this exam-
ple, it is 1

1 (This id comes frommdl_
mnet_host defining your
Moodle server having the
forum announcement service
plugin.)

The id entered
into mdl_mnet_
service, for this
example, it is 4

1 0

The next
highest
value, for
this exam-
ple, it is 2

0

The id entered
into mdl_mnet_
service, in this
example, it is 4

1 0

TheMySQL insert statements for the above:

insert into mdl_mnet_service (id,name,description,apiversion,

offer) values (4,'forum', 'course announcement service', 1,
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1);

insert into mdl_mnet_rpc (id,function_name,xmlrpc_path,parent_

type,parent,enabled,help)

values (15, 'forum_add_discussion1',

'mod/forum/rpclib.php/forum_add_discussion1', 'forum', 'mnet',

1, 'Post a message to a forum');

insert into mdl_mnet_service2rpc (id, serviceid, rpcid) values

(15, 4, 15);

insert into mdl_mnet_host2service (id, hostid, serviceid, pub-

lish, subscribe) values (1, 1, 4, 1, 0);

insert into mdl_mnet_host2service (id, hostid, serviceid, pub-

lish, subscribe) values (2, 0, 4, 1, 0);

Prior to using these statements, first verify the correct table ids in these insert state-
ments.

Configure Camtasia Relay to Send Notifications to Moodle

1. Go toProfiles > Notification Server Setup > Moodle Server tab.
2. Enter a title (name) for the server.
3. Enter MoodleServerURL.

For example: http://moodle.our-university.edu.

If theMoodle server is configured to use a port other than the default of 80, the URL you need to include
the port. For example, if you are runningMoodle on your own computer using port 8080, the URLwould
be http://localhost:8080.

4. Enter theServer path.

Typically this is mnet/xmlrpc/server.php or moodle/mnet/xmlrpc/server.php. This can
vary depending on your Moodle configuration.

5. Enter theService path.

Typically this is mod/forum/rpclib.php/forum_add_discussion1, if the rpclib.php is used as
provided by TechSmith.

If desired, youmay implement your own XML-RPC method using the same parameters as forum_
add_discussion1. The Service Path described above would need to be set appropriately.

6. Click Save.

See Also

Install the Camtasia Relay Plug-In on the Moodle Server
Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Troubleshooting Sending Notifications to Moodle
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Troubleshooting Sending Notifications to Moodle

Below is a simple Python 3.x script that can be used to troubleshoot theMoodle course announcement plug-
in. To use it, you will need to:

1. Install Python 3.0+ on a client computer.
2. Copy the script below into a file on the client computer, e.g., xmlrpc-moodle.py.
3. Edit serverUrl and server to match your Moodle server configuration.
4. Run the script like something like this: C:\python31\python.exe xmlrpc-moodle.py

# For use with Python 3.x

import sys

import time

import xmlrpc.client

timestamp = time.strftime("%Y-%m-%dT%H:%M:%S") # iso_time

# Server settings

serverUrl = "http://localhost:80/"

server = "moodle199" # can be empty if the serverUrl identifies the

server

service = "forum_add_discussion1"

username="admin"

# format and mailnow are hardcoded for now

format=1

mailnow=1

# Announcement settings

courseshortname="CHEM101"

subject="python3 test's subject " + timestamp + ", <a

href=\"http://www.techsmith.com/\">TechSmith!</a>"

message="python3 \"test's\" msg " + timestamp

# RPC call and results

rpcServerUrl = serverUrl + server + "/mnet/xmlrpc/server.php"

service = "mod/forum/rpclib.php/" + service

xmlRpcServer = xmlrpc.client.Server(rpcServerUrl)

print("*** Calling XML-RPC service {0} on server URL {1}".format
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(service, rpcServerUrl))

try:

result = xmlRpcServer._ServerProxy__request(service,

(courseshortname, subject, message, format, username,

mailnow))

print("result =", result)

except Exception as e:

print("Unexpected error:", sys.exc_info())

raise

See also

Install the Camtasia Relay Plug-In on the Moodle Server
Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Configure Camtasia Relay to Send Notifications to Moodle

Notification Setup
Set up notifications to let administrators, presenters, or viewers receive information about processed pre-
sentations.

You can set up notifications to be sent by email or posted on Blackboard or Moodle.

Create a Notification

1. On the Notification Setup page (Profiles > Notification Setup), click one of the notification servers.
2. Enter information for the notification. Depending on which server type you select, you will enter dif-

ferent types of information.

You can use variables to allow one notification to be used inmultiple cases. For more information, see
Variables.

3. Select aDetails Template to use.

Click Samples to preview what information each template includes.

This template defines what information to include in the notification. A notification contains information
for each encoding you select to include in this notification in the profile.

ChooseMessage only if you only want to specify amessage and not include additional details.

4. Enter amessage to include in the notification. This can be a personalized greeting, additional pre-
sentation information, or left blank. You can use variables in this field.

5. Click Save.

Things to Consider About Notifications

The following informationmight help you inmaking some decisions when creating notifications.
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When you set up a profile, you can choose which encodings you want to include in each notification.

For example, you could create a profile that contains both aWeb video and a CAMREC file. You can
include theWeb video information in a notification that goes straight to viewers and include information
on the CAMREC file in a notification that goes only to the presenter.

You can preview the information included in each of the details templates by clicking the Samples link.
For more information on the details templates, seeDetails Templates.
You can use variables to allow for a single notification to be used for multiple uses.

For example, use the system variable {s:PresenterEmailAddress} in the To field of an email noti-
fication. Any profile that uses that notification always sends an email to the email address of the pre-
senter associated with the presentation.

If you use variables in themessage of a notification, some variables only receive information from the
last processed encoding in a presentation.

For example, if you use the system variable {s:PublishFilePath} in themessage of a notification and
havemultiple encodings set up in the selected profile, only the file path of last published encoding are
included in themessage.

Camtasia Relay does not send separate notifications for each encoding selected in a profile, but
instead rolls information for each encoding into a single notification.

For example, if in a profile, you select to include three encoding types in a notification, the recipient
receives one notification including information about all three encodings rather than three separate noti-
fications.

Details Templates

The following details templates are available to use in your notifications. These samples contain example infor-
mation to demonstrate what information is included in notifications that use each template.

If you do not want to include any details, select theMessage Only template. This template will
only include the text you enter in themessage field.
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Administrator

Presenter
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Viewer

Variables
Variables can help simplify themanagement of profiles, publish destinations, publish accounts, and noti-
fications. These “placeholders” have a value applied to them at the time a presentation processes.

There are three different types of variables available:

System Variables

Select from variables included in the Camtasia Relay system and that change their value based on the
information for the presentation that is being processed.

Global Variables

Create a variable, use the variable in multiple places, andmanage the value in central location.

Profile Variables

Create a variable, use the variable in multiple places, and define the value per profile.

Where and How to Use Variables

Variables are available in multiple fields on the Camtasia Relay website, but you use the same interface to
access them in all locations.

Where Can I Use Variables?

Variables are available in publish destinations, publish accounts, and notifications. You can use them
to reuse file paths, URLs, folder names, email recipients, notificationmessages, andmore

Next to each field that can accept variables, you will see the Variable button.
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How Do Add a Variable to a Field?

To use a variable:

Click theVariable button to open theVariable Selectionwindow.
Select a Variable type (Global, System, or Profile).
Select a variable from the list of variables of the selected type.
Click Add. The variable is added at the cursor location.

Repeat as needed. You can use the window to add variables and to edit the content of the field.
When you are done, click OK to close the window.

System Variables

System variables have dynamic values that change based on the presentation that is being processed. These
variables are included with the Camtasia Relay system and include the following:

Variable Name Variable Value

{s:EncodeSettingTitle} Title of the encode setting used to process a presentation.

{s:PresentationDescription} Description of the presentation.

{s:PresentationDuration} Duration, in milliseconds, of the presentation.

{s:PresentationResolution} Maximum resolution in the presentation.

{s:PresentationTitle} Title of the presentation.

{s:PresenterEmailAddress} Email address of the presenter associated with the pre-
sentation.



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - 82 -

Variable Name Variable Value

{s:PresenterName} Name of the presenter associated with the presentation.

{s:PresenterUserName} Username of the presenter associated with the presentation.

{s:ProfileDescription} Description of the profile used to process the presentation.

{s:ProfileTitle} Title of the profile used to process the presentation.

{s:PublishDestinationTitle} Title of the publish destination of the presentation.

{s:PublishFileDuration} The duration of the published presentation, in milliseconds.

{s:PublishFileName} File name of the presentation.

{s:PublishFilePath} The output path of the published presentation.

{s:PublishFileSize} The file size of the published presentation.

{s:RecordDateTime} Date and time the presentation was recorded.

{s:RecorderComputerName} Name of the computer that recorded the presentation.

{s:RecorderIpAddress} IP address of the computer that recorded the presentation.

{s:RecordSettingTitle} Title of the record setting used to record the presentation.

{s:ServerUrl} URL of the server that processed the presentation.

{s:SourceFileSize} Size of the original recording of the presentation.

{s:StartProcessingDateTime} Date and time the presentation started processing.

Example Uses

Use the variable for the presenter’s username in a publish destination file path such as:

\media.company.com\presentations\{s:PresenterUserName}

When the presentation is published, the presenter’s username is substituted in the file path and places
the presentation in that presenter’s network folder.

Use the variable for the presenter’s email, {s:PresenterEmailAddress}, in theRecipient email
field of an email notification. This notification is always sent to the presenter of the presentation, with-
out having to create a notification for each user.
Use the variable for the presentation title in theSubject field of an email notification. Use something
like “Presentation Ready for Viewing: {s:PresentationTitle}” to let the recipients know what pre-
sentation is ready from just the subject of the email.
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See also

Where and How to Use Variables
Global Variables
Profile Variables

Global Variables

Global variables are static strings defined by an administrator. Changes made to the values of these variables
are instantly reflected wherever they are used in Camtasia Relay.

Create and use a global variable when you have a value that is used across multiple profiles and needs to
change at some point.

Example Uses

Create a variable forSemester and add it to a file system publish destination path, such as:

\\media.company.com\presentations\{g:Semester}

You can use this publish destination for multiple profiles. When the semester is over, change the value
on theProfiles > Variables > Global Variables tab and all profiles are automatically adjusted to
reflect the change.

Create a variable for the person to contact if a presenter needs assistance with editing a CAMREC file.

Use the variable in the email notification to the presenter.

When the responsibility to help presenters passes to a new person, you can easily change the variable
value on theProfiles > Variables > Global Variables tab.

See also

Where and How to Use Variables
System Variables
Profile Variables

Profile Variables

Profile variables have dynamic values that are profile specific. These variables can be used inmultiple profiles
but the value is defined per profile.

To fill in the value for a profile variable, go toProfiles > [Select a Profile] > Variable Definition tab.
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Example Use

Your organization’s network folder structure contains a “department” value. If you want a profile for each
department, create a variable for Department. Use this variable in a publish destination such as \\media.-
company.com\presentations\{p:Department}\{s:PresenterUserName}.

When you create a profile, you are prompted to define the value of the profile variable. In this case, the depart-
ment name that is also found in the network folder structure.

See also

Where and How to Use Variables
System Variables
Global Variables

Users Menu
The Users menu allows you tomanage Camtasia Relay users and related settings. The following pages are
available in this menu:

Users
LDAP Import
LDAP Configuration
User Account Security Settings

Users
The Users page contains a list of the current users in the Camtasia Relay system. On this page you can:

Review the users in the system. At a glance, you can see:
Usernames
Name (user’s “real” name)
Email Address
User Type (created in Camtasia Relay or imported from LDAP)
Access Level (Administrator, Presenter, Globlal Caption Editor, No Access)

Click a user to edit user information (Camtasia Relay-created users only)
Username
Name
Access level
Email address
Password
Modify a presenter’s available profiles

Delete a user
Add a Camtasia Relay user
LDAP Import

More than One Kind of User

Camtasia Relay allows you to use both LDAP users and Camtasia Relay created users.

Some examples of why youmay want to use both LDAP and Camtasia Relay managed users:
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You use LDAP and need a temporary account for a visiting presenter.
You use LDAP and need a presenter account for someone already in the system as an administrator.

Manually Add Camtasia Relay Users

If you do not use LDAP for authentication, you can create users manually in Camtasia Relay.

You can have both LDAP and Camtasia Relay created users.

To Create a New User

1. Go to theUsers page.
2. Click theNew User link.

3. Enter a username.

This is the username the presenter uses to log in to the Camtasia Relay website and recorder.

4. Enter the name (given name). This is associated with the recordings.
5. Select Presenter orGlobal Caption Editor in the Access Level dropdown list.

No Access restricts the user from logging into the website and Recorder. For example,
you can use it to turn off a presenter’s privileges at the end of a semester/term.

6. Enter an email address.
7. Enter and confirm a password.
8. Click Save orSave & Add.
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LDAP Import
Add LDAP Users

If your organization uses LDAP, first you need toConfigure Relay to Use LDAP. After LDAP is configured,
then you can either set up Camtasia Relay to automatically add LDAP users or you canmanually add LDAP
users.

You can have both LDAP and Camtasia Relay created users.

Manually Add LDAP Users

Camtasia Relay can reference an LDAP directory to populate the user database. There are two ways to
import users into the Camtasia Relay database.

At the end of the LDAP setup wizard, click Manually import Users to import users immediately.
When LDAP is enabled you can also import users from theUsers > LDAP Import page.

You can use search criteria, such as username, name, email, or LDAP attributes, to find users to add to Cam-
tasia Relay.

Automatically Add LDAP Users

To ease administration of Camtasia Relay, you can enable a system option to import an LDAP user when
they log into Camtasia Relay (website or recorder) with valid LDAP credentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get Camtasia Relay set up when you use LDAP authentication.

To automatically add users with LDAP:

1. Go toSystem > System Options > Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the Camtasia Relay website or the Camtasia Relay recorder with
LDAP usernames and passwords, they are automatically added to Camtasia Relay. If you enabledAuto
Associate Profiles, presenters can access the selected profiles immediately. This is a great way to reduce
the amount of administration work for getting new users started with Camtasia Relay.

This is not done on the User page, but to ease administration of Camtasia Relay, you can enable a system
option that imports a LDAP user when they log into Camtasia Relay (website or recorder) with valid LDAP cre-
dentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get Camtasia Relay set up when you use LDAP authentication.

LDAP Configuration
To configure LDAP, you should first set up a RelayPresenter Service Account.
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RelayPresenter Service Account

Prior to configuring Camtasia Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, Camtasia Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

Camtasia Relay never stores LDAP passwords with the exception of the password of this service account.

The service account should have a password that does not expire. Camtasia Relay ceases to
function for all users if the password of the service account in LDAP is not the same as the
password stored in the Camtasia Relay database.

Configure Relay to Use LDAP

1. Go toUsers > LDAP Configuration.
2. Click Configure LDAP.
3. Enter server information:

Server address
Port

Use secure authentication: Select if you want to connect to the LDAP server over SSL.
Trust all certificates: Enable if you cannot connect over SSL due to an invalid certificate.
If you have a valid self-signed certificate, import the signing certificate into the Trusted
Root Certificate Authority on the Camtasia Relay Server for better security.

Authenticationmethod (Basic or Negotiate)
Username & password to authenticate

4. Click Next.
5. Select the returned base distinguished name or enter another.

Camtasia Relay returns the root of the LDAP directory, and pre-fills the Base distinguished name field.
Or, if you know exactly where your users reside in the LDAP directory, you canmanually enter the
Base DN.

6. Click Next.
7. Select the “RelayPresenter” service account as the representative user with the following attributes:

Full name
Username
Email address

8. Click Next.
9. Map the attributes from the selected user to the fields Camtasia Relay requires.

You can choose from the dropdown list of attributes returned from LDAP or type in an attribute if it is
not found in the dropdown list.

10. Click Next.
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11. Review the configuration information.
12. Enter a valid username and password into the Test Authentication fields and click Test.
13. Click Finish.

You can now configure Camtasia Relay toAutomatically Import Users with LDAP orManually
Add LDAP Users.

If you disable LDAP, users remain in the Camtasia Relay database. However, since Camtasia
Relay never stores LDAP-associated passwords, users cannot access the Camtasia Relay
website or make recordings.

To re-enable users, select a user then click theConvert to Relay link. The user is emailed a
randomly generated password. The user must access the Camtasia Relay website and
change their random password.

User Account Security Settings
To help secure Camtasia Relay, you can set the following:

Recorder Security Settings
Forgot Password Settings
Account Lockout Settings
Password Complexity

Recorder Security Settings

Tomanage the security of the Camtasia Relay recorders, you can choose to enable or disable the following
options.

Ignore Server Certificate Errors

If your server certificate is invalid, Camtasia Relay notifies you on theDashboard and the Recorder Security
settings page.

Enable this option if you need to let the recorder connect to the server even if the server has an invalid
server certificate. When enabled, the Camtasia Relay recorders ignore all server (SSL) certificate
errors when connecting to the Camtasia Relay server.

This option should be used as a temporary solution as it reduces the security of the
Camtasia Relay server.

Disable this option if you have security concerns and want to be sure that recorders only connect
when there are no SSL certificate errors.

More information about certificate errors:

When you change this option, Camtasia Relay recorders will be unavailable until they are rebuilt to
reflect this security change.
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It may take several minutes before the Camtasia Relay recorders are again available for download.
Allow about fiveminutes for the updated recorders to be available on theSystem > Download
Recorders page.

Recorders downloaded before changing this option cannot connect to the server andmust be updated.
Please inform presenters that they must download and install a new recorder from the Camtasia Relay
website. Presenters are not informed automatically.

Expire Recorder Authentication Codes

Enable this option to have presenter authentication codes expire. This can prevent an attacker from learning a
presenter’s code, posing as the presenter, and sending requests to the server.

This may affect presenters that select Remember me in the recorder. When the authen-
tication code expires, the presenters need to log in again.

See also

Forgot Password Settings
Account Lockout Settings
Password Complexity

Forgot Password Settings

You can allow users to change forgotten passwords. Set the amount of time (in minutes) that a change pass-
word link is active and how often users can request a new password.

See also

Recorder Security Settings
Account Lockout Settings
Password Complexity

Account Lockout Settings

You can allow accounts to lock after a given number of failed logins. Also set the length of time to lock an
account, how often to reset login attempts, and whether users can unlock accounts using CAPTCHA.

CAPTCHA Option to Unlock Accounts

CAPTCHA uses distorted text in an image to help protect websites frommalicious computer programs.
CAPTCHA helps tomake sure a person trying to access the website, not a computer program.

Enable this option to allow users to unlock their accounts by typing in the distorted text shown in the image.
Using this option should help to cut down on emails to administrators by users locked out of accounts.

See also

Recorder Security Settings
Forgot Password Settings
Password Complexity
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Password Complexity

Create rules for password complexity that adhere to organization standards. You can set the following pass-
word attributes:

Password character length
Uppercase and lowercase character requirements
Letters and numbers requirements
Special character (~!@#$%^&*.-_+?;) requirements

See also

Recorder Security Settings
Forgot Password Settings
Account Lockout Settings
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Need More Help
In addition to the in-product help files, there are several different ways to get help for using Camtasia Relay.

Camtasia Relay Learning Center

Looking for “How to…?” or “How do I…?” information? In the Camtasia Relay section of the Tech-
Smith.com Learning Center you can find themost up to date tutorials and product information.

TechSmith Technical Support

Having a technical issue? In the TechSmith Support Center you can search for answers to technical
issues and contact support. SeeWorking with Technical Support for more information about how to
contact TechSmith’s Technical Support team.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
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Working with Technical Support
In the event you have an issue that cannot be answered with the Camtasia Relay Help and documentation,
please follow the steps below when working with TechSmith Technical Support.

Step 1: Knowledge Base Search
Before contacting TechSmith for Technical Support, pleasemake sure to search the Knowledge Base on the
Support Center (http://support.techsmith.com). It is possible that the issue is a known issue and there is
already an answer available.

Before running a search, select Camtasia Relay and the version number in the dropdown lists.

Step 2: Submit a Question
If you are unable to find an answer to your issue, send a question to Tech Support.

1. On the Support Center page (http://support.techsmith.com), click Ask aQuestion.

2. Fill in the requested information, making sure to select your current Product Version, Operating Sys-
tem, and Problem Type.

For a question regarding a program error, please select Other under Problem Type.

3. If you are a first-time user, you are prompted to create a user account.
Tips for Submitting a Question

When opening a support ticket, please include as much information regarding the nature of the problem
as possible.
To speed up the debugging process, attach one or more of the following to the support ticket:

Screenshots
Application logs

http://support.techsmith.com/
http://support.techsmith.com/
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Other diagnostic information
Event Viewer logs

These are particularly useful. The steps inHow to Export Event Viewer Logs explain how to
export the logs for Camtasia Relay components.

Step 3: Call Tech Support
The Camtasia Relay Tech Support team is ready and waiting for your questions. Should you have problems
that you cannot solve using the resources provided, please give us a call and wewill be happy to assist.

The following information is available on the TechSmith website by clickingCompany > Con-
tact Us. Always refer to that location for latest, most accurate information.

Phone: +1.517.381.2300 (ext. 784)
Toll Free in the U.S. & Canada: +1.800.517.3001 (ext. 784)
Tech Support Website: http://support.techsmith.com

How to Export Event Viewer Logs
The following information explains how to export the event viewer logs for the components of Camtasia
Relay.

If the TechSmith node is not present on a server where Camtasia Relay Server has been
installed, this means that the Relay Manager Service never started on that server. If the server
isn’t running and you there isn’t a TechSmith node in the Event Viewer, try the Restart Cam-
tasia Relay Server shortcut on the desktop, it may solve the problem.

Camtasia Relay Recorder

Windows XP

1. Go toStart > Run > eventvwr.
2. Right-click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click Application and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click System and select Save Log Files As.
7. Save the log in the EVT format.

Windows Vista and Windows 7

1. Open the Start menu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.

http://support.techsmith.com/
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6. Right-click Application and select Save Events As.
7. Save the log in the EVTX format.
8. ExpandWindows Logs.
9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.

Windows 8

1. Open the Start menu and search for “event viewer.”
2. Click Settings. On the left, click Event Viewer.
3. When the Event Viewer opens, expandApplications and Services Logs.
4. Right-click TechSmith and select Save Events As.
5. Save the log in the EVTX format.
6. ExpandWindows Logs.
7. Right-click Application and select Save Events As.
8. Save the log in the EVTX format.
9. ExpandWindows Logs.
10. Right-click System and select Save Events As.
11. Save the log in the EVTX format.

Mac OS X

1. i. Open Finder and go to /Library/Logs/TechSmith/.
2. ii. Right-click Camtasia Relay and select Compress Camtasia Relay to create a ZIP file of the log

files on the desktop.

Camtasia Relay Server

Windows Server 2003

1. Go toStart > Administrative Tools > Event Viewer.
2. Right click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click TechSmith and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click Application and select Save Log Files As.
7. Save the log in the EVT format.
8. Right-click System and select Save Log Files As.
9. Save the log in the EVT format.

Windows Server 2008 and Greater

1. Open theStartmenu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.
6. Right-click Application and select Save Events As.



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - 95 -

7. Save the log in the EVTX format.
8. ExpandWindows Logs.
9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.
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